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Important Customer Information about CoCut 
Professional 
 
Please check the contents of your software package as soon as possible upon receiving 
it. Should any items be missing, immediately contact the dealer from whom you have 
purchased the software. 
 
CoCut Professional is available in two different versions: 
 
CoCut and CoCut Professional 
 
The two versions differ with regard to the number of tools and items supplied. 
 
Both versions of CoCut are supplied with the CoCut Professional manual, which 
describes all the tools of the two versions in detail. Thus some tools may be described in 
the manual which are not included in your version of CoCut. 
 
A complete package of CoCut Professional should contain the following items: 
 
• 1 CD  
• Copy protection key/dongle 
• User manual 
• Registration card 
 
Besides the program cd-rom, the most important item is the copy protection key/dongle. 
The number printed on the dongle must match the serial number located inside the front 
cover of your manual. 
 
Underneath the dongle number, you will find your personal code. 
 
Your code number consists of the following numbers: 
 
Dongle-No.-CC11-7 digits-6 digits 
 
If you have CoCut Professional you will find CC11P after the dongle no. 
 
Examples: 
102300-CC11-1234567-123456 (Code No. for CoCut) 
102300-CC11P-1234567-123456 (Code No. for CoCut Professional) 
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This code number must be entered upon successful installation and initial startup of the 
software. Make sure you enter the number correctly, or you will not be able to restart the 
program. 
 
May 2003 
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Dear Customer, 
 
In an effort to help you solve any problems and answer your questions as quickly and 
efficiently as possible, we provide our Technical Support Line. This is a toll-free 
number you can call if you have any technical questions about our products. 
 
This service is available to you free of charge. 
 
Mon. - Fri. from 9.00 am to 12.00 am 
 
Horst Krämer Tel. ++49 6502 9288 11 
 
You can find further useful information including tips and tricks on our web site: 
 
h t t p : / / w w w . e u r o s y s t e m s . l u  o r  h t t p : / / w w w . c o c u t . c o m  
 
under the rubric Support. 
 
Our support staff have been instructed only to provide assistance to registered users.  
 
When calling, faxing or e-mailing, please provide the following information: 
 
 - Dongle number of your EUROSYSTEMS product 

- Version number, i.e. CoCut Professional 6-11 
- Date of manufacture of your original CD 

 
Please understand that we can only answer enquiries addressed to this telephone 
number. Other telephone numbers are reserved for marketing, purchasing and sales. 
 
In order to obtain the best possible technical support, we urge you to register your 
software. Immediately upon receipt of your registration card by fax or online, you will be 
entered in our Customer Support database. 
 
RCS Systemsteuerungen GmbH 
General Distributor for EUROSYSTEMS products. 
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Copyright 
Copyright©2003 by EUROSYSTEMS S.à.r.l., Luxembourg. All rights reserved. 
The CoCut Professional software for Windows and this publication are licensed property 
of EUROSYSTEMS S.à.r.l, Luxembourg, 7,rue des Tanneurs, L-6790 Grevenmacher. 
Any reproduction or transmission in any form, by any method or for any purpose of the 
software or of this manual, in whole or in part, is strictly prohibited. 
 
User manual text/ typesetting/ layout: 
Georg Wagner, Peter Bettendorf  
RCS Systemsteuerungen GmbH, Longuich 
 
English translation: Hilary Teske  
 
This software is licensed for the exclusive use of the original purchaser and is to be used 
on one computer system only. Similar to a book, this software can be moved from one 
location or computer to another, as long as there is no possibility of it being used at two 
locations, or by more than one person, simultaneously. 
 
The licensee may make one copy of the software for backup purposes only. 

Limitation of Liability 

Utmost care has been taken in the compilation of this manual and the text and 
illustrations therein; however, no guarantees can be made as to the completeness or 
perfect accuracy of the manual or the program itself. 
In no event shall EUROSYSTEMS, its dealers or distributors, be liable for lost profit, data, 
or information of any kind, or for any special, collateral, incidental, consequential, 
indirect, punitive, or any other type of damages in connection with or arising out of 
purchase or use of CoCut Professional or its documentation. The information contained 
in this manual is subject to change without notice and does not represent a commitment 
on the part of the vendor. 

Trademarks 

Adobe Type Manager, AMD, Intel, CorelDRAW, Postscript, Microsoft, Windows, and 
other brand or product names used in this manual are trademarks or registered trade-
marks of their respective holders/ manufacturers.  
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Hardware and Software Requirements  
• The minimal requirement is a Pentium 350 with 64 MB of RAM 

 
• Windows 98 or later version 
 
• Video Display running at 800 x 600 pixels with 16 colors 
 
Note: You will find further information on this point in the Hardware and Software 
Requirements for CorelDRAW 6, 7, 8, 9, 10 and 11, page 2 ff. 

User Manual Format 

To make this manual more easily readable, the same symbols and type styles are used 
throughout. The following is an explanatory chart designed to help you find and interpret 
these visual aids more easily. 

Visual Aid Chart 

 
Symbol / Type Style Interpretation 
 
Bold Headings 
   
Italic Notes 
 
Bold, italic Menus, e.g.: File Menu 
 
Bold, italic Tools, boxes, options, commands, icons  
 e.g.: New command 
 
CAPITALS Keys, e.g. SHIFT 
 
 
KEY1+KEY 2 The plus sign (+) between two keys means that you 

have to hold down the first key when you press the  
 second key. Then you release both keys. 
 
KEY1,KEY 2 A comma (,) between two keys means that you press 

the keys one after the other and release them. 
 

 Shortcut 
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Introduction 
CoCut Professional™ is add-on software for cutting vinyl from CorelDRAW™. On 
account of its wide range of graphic possibilities, CorelDRAW is eminently suited to 
producing high-quality drawings that can easily be printed using powerful printer drivers.  
If, however, you, wish to use cutting plotters, you may encounter major difficulties due to 
the lack of a standard language for driving plotters and the different output formats.  
A solution to these problems is to use stand-alone cutting software, which is often 
completely isolated, thus making it impossible to exchange data with other systems or 
programs such as word processing or design applications.  

What CoCut Professional Can Do  

• CoCut Professional is able to work with many different plotters and adapt to their 
particular features. Among these are plotters of well-known manufacturers such as 
Summagraphics, Mimaki, Roland, Gerber, Zünd, etc. 

 
• CoCut Professional automatically converts lines to cuttable contours. 
 

• Cutting by color and precise mounting using register marks  
 
• Color welding: user-defined color overlaps and screen-printing overlaps with user-

defined color sequence. 
 

• Cutting preview of vinyl width and display of the amount of vinyl used.  
 

• Positioning, resizing, duplicating, etc. of objects. 
 
• CoCut Professional evaluates the data produced by CorelDRAW and prepares it for 

cutting on the selected plotter. 
 

• CoCut Professional can cut even extremely large drawings without any difficulty. 
You can resize and segment your drawings to any scale you wish, no matter what 
the size of the drawing in CorelDRAW. 

 
• If the drawing is too wide for your plotter, it will be automatically sectioned, i.e. 

divided so that your plotter can cut it. 
 

• You can set up default values for printing and speed for different materials. These 
values can be stored in a material database for reuse at any time. 
 

• While your plotter is cutting, you can continue working with CorelDRAW or any 
other Windows program. The plotter works in the background (with serial drive). 
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1. How to Install CoCut Professional 
General information on installation. 

Hardware and Software Requirements for CorelDRAW 6, 7, 
8, 9, 10, 11, 12 & X3 

The system requirements for CoCut Professional™ are the same as for the CorelDRAW 
version you are using.  
CoCut Professional will not work properly unless your system is correctly configured for 
using CorelDRAW. 
 
To use CoCut Professional 6, 7, 8, 9, 10 and 11 you need the following equipment: 
 
• A Pentium II 350 is recommended for CorelDRAW versions 7, 8, 9, 10 and 11.  

 
• 128 MB of RAM, 

 
• Microsoft Windows 98® ,ME®, NT®; 2000®, XP® CorelDRAW 6, 7, 8, 9, 10 & 11 are 

not compatible with Windows® 3.1 
 

• Please use only the cable supplied by your plotter manufacturer for transmitting data 
from your computer to your plotter. If you encounter any problems, please contact the 
manufacturer or your dealer for assistance.  

 
• As CorelDRAW is a very large program, you will need 250 MB of RAM on your hard 

drive. For a typical installation you will need more than 150 MB of RAM. So that you 
can work without any problem, your system should have 100 MB of RAM. 

 
Note: Close all Windows programs except the Program Manager. If you fail to do this, 
errors may occur in updating some system files. 

Installing Windows and CorelDRAW™  

Before you install CoCut Professional, both CorelDRAW and Microsoft Windows 98, 
ME, NT, 2000, XP must be installed and ready for use. If this has not been done, first 
install your version of Windows and then CorelDRAW. Make sure that CorelDRAW 
works properly by making a test printout.  
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Windows 98, ME, NT, 2000, XP 

• Place the CoCut Professional installation CD in the CD drive. 
• The CoCut Professional autostart starts the installation routine.If installation doesn’t 

start automatically, proceed as follows: Click on the Windows Start button and 
select Execute. 

• Irrespective of your drive name, type e:\setup.exe or b:\setup.exe in the command 
line. 

• Start the installation by clicking on the OK button. 
 

Note: See that the Script-Compiler is also installed with CorelDRAW 6 to ensure that 
CoCut Professional is correctly installed. This option is automatically selected if you have 
chosen a complete installation. 
 
Note: Errors which may occur in installation and ways to remedy them are described 
later in this manual. 

Configuring the Serial Port  

For CoCut Professional to work properly it is essential that the settings are the same on 
both plotter and serial port, i.e. the Baud rate, Data bits, Parity, Stop bits and Flow 
control are configured identically. 
 
Example: Baud rate: 9600, Data bits: 8, Parity: none, Flow control: Hardware 
 
Note: The settings recommended in your plotter software instructions have to match the 
settings made when you install CoCut Professional, otherwise conflicts may arise. 



 

 

INSTALLATIONChapter 1 

6

Attaching the Dongle 

It is necessary to have a dongle to operate CoCut Professional. This is the small black 
box in the CoCut Professional package. The dongle has to be plúgged into a free 
parallel port on your computer. 
 
These dongles are used by us: 
 
Memo HASP for parallel port 

 
Memo HASP for USB port 

 
MARX (old CoCut Dongle: doesn’t work with CoCut or CoCut Professional 11) 

 
If you plug in the dongle between your computer and a printer, the printer must in any 
case be switched on and online when you wish to cut, otherwise the dongle will not work 
properly.  
 
For this reason we recommend plugging it into a free parallel port without a printer.  
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CoCut Professional Installation 

CoCut Professional 11 comprises one CD.  
 
Step 1: Plug the dongle supplied with CoCut Professional into your computer’s 

parallel port (printer port LPT1). Secure the dongle by tightening the two 
screws or simply plugging it into the USB port for a USB dongle. 

 
Step 2: Windows 98 & ME: 
 Choose the Port icon under Start/Settings/Control Panel/Plotter 

Manager  
 

Windows NT, 2000 and XP 
If you are using NT, 2000 or XP Windows NT as operating system, you 
will find the Port icon under Start/Settings/Control Panel. 

 Select the port to which your plotter is connected (e.g. COM1). 
 The default settings are as follows: 
 
 Baud rate: 9600 
 Data bits: 8 
 Parity: none 

 Stop bits:  1 
 Flow control: Hardware 

 
 Check the other settings, which should be as follows: 
 
 COM 1: I/O address 03F8 and IRQ 4 
 COM 2: I/O address 02F8 and IRQ 3 
 
Step 3: Windows 98, ME, NT, 2000 and XP: 
 Select Execute in the Start menu. Place the CD in the CD drive. 
 Type A:\setup or E:\setup in the command line depending on the name 

of your disk or CD drive. 
 
 After a short time a window entitled “CoCut Professional Setup“ appears. 
 
Step 4 Use the Continue button to proceed with the installation routine. 

“EUROSYSTEMS Licencing Agreement“ Dialog Box Once you have 
accepted the conditions of the EUROSYSTEMS licencing agreement, the 
actual installation starts. 
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 “User Information“ Dialog Box 
 
Type your personal data (name, company, serial number) here. 
Example: Serial number: 012345-xy-1-123456-654321 

  
 “Select Target Path“ Dialog Box  
 In this dialog box you can select the directory in which CoCut 

Professional is to be installed. C:\EUROSYSTEMS\COCUT is the 
default suggestion. 

 If you wish to install CoCut Professional in another directory, please 
activate the Search button enter the desired target directory under Path 
and in the dialog box which appears. 

 
 “Select Program Folder“ Dialog Box 
 Here the EUROSYSTEMS/CoCut Professional folder is the default 

suggestion. You can define a new program folder in the Program Folder 
command line.  

   
 “Setup Ended“ Dialog Box 
 Confirm this dialog box using the Exit button. 
 
Step 5 Close all applications and restart your computer. 
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The CoCutSkin 

After you have installed CoCut Professional and started CorelDRAW, the CoCutSkin 
appears on your desktop. 
 
Note: The CoCutSkin will not be installed unless you have installed CorelDRAW 9, 
CorelDRAW 9 Office, CorelDRAW 10 or 11 and the Internet Explorer Version 5 or later 
on your computer. 
 

 

Fig.1: CoCutSkin 

 CoCutSkin always in front 
 

 closes CoCutSkin 
 

 transmits data to CoCut Professional 
 
Note: If CorelDRAW is minimized, the CoCutSkin will disappear. If CorelDRAW is 
switched to full screen, the CoCutSkin will reappear. 
 
If you close the CoCutSkin using the  button, you can open it again under Start/ 
Programs/EUROSYSTEMS/CoCut Professional/ CoCutSkin for CorelDRAW. 

Toolbar button with CoCut Professional™ Macro (Corel 6) 

• Select the menu Tools/Customize 
• Click on the Toolbars tab 
• Double-click on Script Applications 
• Select from the General Scripts folder the script CoCut 6.csc. 
• Choose any symbol you wish and drag it to the CorelDRAW toolbar with the left 

mouse button held down. 
• Click on OK in the Customize dialog box 
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Toolbar button with CoCut Professional™ Macro (Corel 7) 

• Select the menu Tools/Customize 
• Click on the Toolbars tab 
• Select from the Application Scripts folder the script CoCut 7.csc. 
• Choose any symbol you wish and drag it to the CorelDRAW toolbar with the left 

mouse button held down. 
• Click on OK in the Customize dialog box 

Toolbar button with CoCut Professional™ Macro (Corel 8) 

• Select the menu Tools/Options 
• From the left-hand set of options select Workspace/Customize/Toolsbars 
• Select from the Application Scripts folder the script CoCut 8.csc. 
• Choose any symbol you wish and drag it to the CorelDRAW toolbar with the left 

mouse button held down. 
• Click on OK in the Options dialog box 

Toolbar button with CoCut Professional™ Macro (Corel 9) 

• Select the menu Tools/Options 
• From the left-hand set of options select Workspace/Customize/Toolsbars 
• Select from the Application Scripts folder the script CoCut 9.csc. 
• Choose any symbol you wish and drag it to the CorelDRAW toolbar with the left 

mouse button held down. 
• Click on OK in the Options dialog box 

Linking CoCut Professional Script with the CorelDRAW 10, 11, 
12 & X3 toolbar 

Important note: CorelDRAW must be installed with the “Visual Basic for Application.” 
This option can be installed as follow: 
 
Insert the CorelDRAW 10 CD in the disk drive / Start setup / Select “Customize setup”.  
If a CorelDRAW 10 version already installed on your computer, first select ” User-defined 
setup” and then “Customize setup”. In the dialog which now opens double-click on Main 
Applications or click once on the Plus. Double-click on Productivity Aids and select 
“Visual Basic for Application”. After installing CoCut you have to link the CoCut script 
with the menubar. 
 
• Select the menu Tools/Adjustment 
• From the left-hand set of options select Workspace/Customize/Command 
• Click once in the File box on the right of the list of options, select Macros and drag 

CoCut10.CoCut... to the menubar of CorelDRAW 10. 
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• Now select the Appearance tab. Click on the Import button and select any symbol 
you want. 

 
Note: The symbol disappears every time you restart CorelDRAW and the book-icon 
(standard default-icon) appears. (CorelDRAW Bug) 
 
• From the left-hand set of options select Workspace/Customize/Command 
• Change the name of the”New sysmbol bar 1” to CoCut.  
• Click OK in the Options dialog box 
 
If you now select one or several objects and click on the installed icon, the objects will be 
transmitted to CoCut Professional and can be plotted. 

Where can I find CoCut Professional in Freehand 8, 9, 10 & MX? 

You can find CoCut Professional in the Xtras menu under Animate and in the Window 
menu / Xtras under Functions. 
How can I import data from Freehand 8, 9,10 & MX to CoCut 
Professional?  
 
Start CoCut Professional and if objects are selected, only the selected objects will be 
exported to CoCut Professional.  
 
Start CoCut Professional and if no objects are selected, all objects located on your 
working area will be exported to CoCut Professional.  
 
Restriction: Fountain fills and lens effects are not supported. 
 
Note: Freehand 8 has a color correction mechanism (like, for example, CorelDRAW), 
which affects the display of colors in Freehand. 
Solution: Turn off this command via File/Settings/Colors. 

Where can I find CoCut Professional in Adobe Illustrator 8, 9,10, 
CS & CS 2? 

You can find Corun in the File menu under Export. 

How can data be exported from Illustrator 8, 9 and 10 to CoCut 
Professional ? 

Start CoCut Professional and if objects are selected, only the selected objects will be 
exported to CoCut Professional. Any texts to be exported will be automatically converted 
to curves. 
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Note: CoCut Professional isn’t active if no objects are selected,.  
 
Restriction: Special fountain fills are not exported. 

Where can I find CoCut Professional in the various AutoCAD 
versions? ! ONLY CoCut Professional ! 

Installation of Menu File for AutoCAD LT 98 

Select Adjust/Menus in the Extras menu. Click on the Scroll buttonin n the dialog box 
appearing This opens the File Selection dialog box. Change the file ending to *.mnu 
um. Select the cocut.mnu file and close the dialog box.  
Click on the Load button and then on OK in the enquiry dialog box.  
The CoCut Professional menu has now been loaded. 
Now switch to the Menu Bar dialog box in the upper tab. Select CoCut Plot and add it to 
the AutoCAD menu in the desired place. 
CoCut Professional is now to be found in the menu list and a CoCut toolbar is added to 
the toolbars. 

Installation of the Menu File for AutoCAD R14 ! ONLY CoCut 
Professional ! 

Select Customize Menus in the Extras menu. In the dialog box appearing click on the 
Scroll button. This opens the File Selection dialog box. Set the file ending to *.mnu um. 
Select the cocut.mnu file and close the dialog box.  
 
Click on the Load button and then on OK in the enquiry dialog box.  
The CoCut Professional menu has now been loaded. 
 
Now switch to the Menu Bar dialog box in the upper tab. Select CoCut Plot and add it to 
the AutoCAD menu in the desired place. 
CoCut Professional is now to be found in the menu list and a CoCut toolbar is added to 
the toolbars. 

Installation of the Menu File for AutoCAD 2000LT & 2000 ! ONLY CoCut 
Professional ! 

Select Customize Menus in the Extras menu. Click on the Scroll button in the dialog 
box appearing. This opens the File Selection dialog box. Changethe file ending to 
*.mnu um. Select the cocut.mnu file and close the dialog box.  
 
Now switch to the Menu Bar dialog box in the upper tab. Select CoCut Plot and add it to 
the AutoCAD menu in the desired place. CoCut Professional is now to be found in the 
menu list and a CoCut toolbar is added to the toolbars. 
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Installation of the Menu File for AutoCAD LT98 and R14 ! ONLY CoCut 
Professional ! 

Select Printer Setup in the File menu. Click on the Open button In the dialog box 
appearing and select the cocut/t98.pc2 (LT98) file or cocutr14pc (R14) file. Close the 
dialog box.  
Now start a printing job by clicking on Print in the File menu to make the following 
settings: 
Click on Plot to File, set the Resize Factor to 1:1 and the Unit to mm. 
 
Note: Make sure the Plot To File checkbox is activated when making the first plot. 
 
This procedure ensures that all drawing elements are transmitted.  
 
The Pen Change commands from the Plot file are interpreted so that 8 layers can be 
separated. 
AutoCAD does not plot with arcs, i.e. all elements are converted into lines and dots are 
interpreted as drill holes. 
 
Note: If you are using DXF, you have to press ENTER twice after selecting the object, as 
the execution of the menu macros is canceled by the object selection. 
 
Note: If you export using DXF, lettering and texts are not exported, but it is possible to 
select objects and plot them. The curves are not converted to lines but are changed from 
the splines or arcs in the DXF file into Bezier curves. 
 
Note: The number of layers is not restricted to 8. 
 
In the Windows autostart group a link to the autoimp.exe program is made during 
installation, so that the data can be exported to CoCut Professional. When autoimp.exe is 
started, an icon will be displayed in the system bar at the bottom right of the screen. 
The program can be ended by double clicking on this icon. 
 
Note: If the icon is turned off, the data will not be exported to CoCut Professional. 
 
The program can be restarted via Start/Programs/Autostart/ Auto-Import for CoCut 
Professional. 
 
Note: When installing, make sure that CoCut for AutoCAD is only installed for the 
AutoCAD version last used when several AutoCAD versions are installed on one 
computer. 
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Setting Up the Port for Data Transmission  

Windows 98®, ME®  

• Click on the Start button and select Control Panel. 
• Double-click on the System icon. 
• Click on the Plotter Manager tab.  
• Click once on the + sign. 
• Double-click on Port.  
• Double-click on the port to which your plotter is connected. (e.g. COM2). 
• Click on the Port Settings tab. 
• Set the flow control to Hardware and make the other settings match the default 

settings on your plotter (see plotter manual). 
• Click on the Close button. 

Windows NT®, 2000®, XP® 

• Click on the Start button and select Settings. 
• Click on the Control Panel tab. 
• Double-click on System/Hardware/Plotter Manager  
• Double-click on the port to which your plotter is connected (e.g. COM2). 
• Click on the Settings button. 
• Set the flow control to Hardware and make the other settings to match the default 

settings of your plotter (see plotter manual). 
• Click on the Close button. 
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2. How to Work with CoCut Professional ! ONLY 
CoCut Professional ! 

2.1 Your Desktop with the CoCut Professional Working 
Area ! ONLY CoCut Professional ! 

In this chapter you will learn the basics of working with CoCut Professional. You will be 
introduced to such items as the desktop, the tools, the text editor, data import and export, 
loading and saving jobs, as well as cutting. 
 
After CoCut Professional has been started, the following window appears: 
 

 

Fig. 2: The CoCut Professional Working Area 

The Rulers can be positioned freely as you wish or completely turned off. 
 
The Units of Measurement (cm, mm, inch) can be changed by simply clicking a button.  
The button is located in the lower right corner where the horizontal and vertical scroll 
bars meet. 
 
In the Status Bar there is extensive information about the objects to be found on the 
working area, such as wireframe, fill, dimensions, number, combination or grouping. 
The various elements in the menu line will be dealt with in detail in the Reference 
Section. 

A) System field 
B) Window title 
C) Title line 
D) Button 

„Symbol“ 
E) Button 

„Full screen“ 
F) Button 

„Exit“ 
G) Menu line 
H) Stnadard bar 
I) Tool bar 
J) Object bar 
K) Layerbox 
L) Metric  

(cm, mm, inch) 
M) Vertical / Horizon. 

rulers 
N) Working area 
O) Vertical / Horizon. 

Scroll bar 
P) Staus bar 

object infos  
Q)  Status bar 

element infos 
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2.2 Explanation of Cursor Shapes in the Working Area  
! ONLY CoCut Professional ! 

Cursor shape Interpretation 
 

 Mouse cursor 
 
Note: Select objects by positioning the mouse cursor on the object and pressing the left 
mouse button. 
 
Cursor shape Interpretation 
 

 Move objects 
 
Note: This type of cursor is only active when the cursor is located in the interior of the 
object or in the area between the 8 black squares on the wireframe. The object must be 
selected. 
 

 Enlarge object vertically 
 

  Enlarge object horizontally 
 

 ,  Enlarge object diagonally 
 
Note: The cursors for modifying the size of objects are only active when the cursor is 
located in the area area between the 8 black squares on the wireframe of the object. 
 
  
You can switch to the Skew/Rotate mode by clicking once on the left mouse button 
with the cross cursor activated. 
 
Cursor shape Interpretation 
 

  Object in Skew/Rotate mode 
 

, , ,  Rotate object 

 ,  Skew object 
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2.3 The CoCut Professional Default Toolbar ! ONLY CoCut 
Professional ! 

 CTRL-1 

Fig.3: Shortcut for Turning the Default Toolbar On and Off 

The first time you start CoCut Professional, you will find the toolbox in the upper left 
corner of your screen. It contains 12 icons.  
 

 

Fig.4: The CoCut Professional Default Toolbox 

Note: You can make the toolbox reappear by clicking on Default in the Window menu. 
 
The toolbox can be moved at any time by clicking the bar at the top and dragging it to the 
desired location.  
 
Notes: When you close the program, CoCut Professional will save the last position of 
the toolbox. 

2.4 The CoCut Professional Toolbor ! ONLY CoCut Professional ! 

 CTRL-3 
 

 

Fig. 5: The Toolbar 

2.4.1 The Arrow Tool 

 

Fig. 6: The Arrow Tool 

The arrow tool, also known as the general work tool, is used to select, move, temporarily 
group and resize text or objects. 
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Select 

Click on any point of the object and it is automatically selected, i.e. a frame defined by 
eight small squares appears around it. When working in the Edit Wireframe (F9) mode, 
you must click on the outline of the object to select it. 
 
Note: To select individual characters in a text string, the text must first be converted to a 
bitmap by using the Text to Curves command in the Edit menu. The selected letter(s) 
can then be detached from the string by pressing SHIFT+L. 

Move 

You can move objects by selecting them and dragging them to the required positon on 
your working area with the mouse button held down. 

Resize 

You can proportionally resize objects by grabbing one of the 4 handles or corner squares 
of the frame around the object. Double-clicking on one of these corner squares opens 
the Object Attributes... dialog box in which you may enter specific values under Size. 
To resize an object non-proportionally, double-click on the squares located between the 
corner markers. 
To resize by eye (proportionally or non-proportionally), simply click on the appropriate 
square and drag it until the desired size has been attained. 

Register Marks 

With this option you can place register (crop) marks in your artwork. This tool permits you 
to mount color-separated cutting jobs with precision. 

You can set register marks by clicking on the  icon in the CoCut Professional 
Toolbar and placing the mouse cursor on the spot where the first register mark is to be 
set. Now click once with the left mouse button and the register mark is set. Proceed in 
the same way to set the other register marks. 
 
Note: Register marks will be cut in every layer regardless of its color. 
 
Example:  
 
To permit you to mount the vinyl colors precisely, the register marks will be cut in the 
same place on the vinyl regardless of its color. 
 
The following objects are located on the CoCut Professional working area and are to be 
cut: 2 blue objects, 1 red, 1 yellow and 1 green one. 
 
It is useful to set register marks so that you can mount the objects precisely later. 
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To do this, click on the appropriate icon in the CoCut Professional Toolbox. 
 

 
Position the mouse cursor at the place next to the objects where you want to set the first 
mark and click the left mouse button once. Proceed in exactly the same way with the next 
two register marks. 

 
Now select all the objects and click on the Cut button. 
 
Click with the left mouse button on the arrow to the right of Objects in the lower right 
part of the Cut dialog box which now opens. A selection box will open in which you can 
choose between various options. 
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For color-separated cutting first select the 
 
 red layer then the green one the blue one 

   

and finally the yellow one   
 
All the layers will be cut one after another and mounted later with the help of the register 
marks. 

Drill Holes 

With this command you can place perforation marks or drill holes in your design. 
 
Note: This option is designed specifically for CoCut Professional users who 
have flatbed plotters with routing capabilities. 
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2.4.2 The Zoom Tool ! ONLY CoCut Professional ! 

This tool is used to zoom in and out on your desktop, working area or design.  
 

 

Fig.7: The Zoom Tool Icon 

When you click on the Zoom icon, a flyout box appears containing five additional icons. 
 

 

Fig.8: Flyout with 5 Zoom Functions 

The icon with the plus sign is used to enlarge a selected area of your desktop. Using the 
framing tool, draw a frame around the area you want to enlarge. You can repeat this 
procedure several times for further magnification. An acoustic alert will warn you when 
you have reached the limit and no further magnification is possible. 
 
Note: You can also execute this command by pressing F2 and the + (plus) key in the 
numeric keypad. 
 
The icon with minus sign is used to reduce the size of a selected area of your desktop or 
working area. 
 
Note: You can also execute this command by pressing F3 and the - (minus) key in the 
numeric keypad. 
 
The icon depicting a sheet of paper is used to view the working area in its entirety. The 
icon depicting a monitor is used to display all objects on your working area. CoCut 
Professional will enlarge or reduce the objects to make just enough room for everything 
to fit on your screen. 
 
The last icon depicting a magnifying glass is used to display all selected objects in the 
maximum possible size. 
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Note: If you hold down the SHIFT key while executing this command, only the selected 
objects will be enlarged to their optimal size. 

2.4.3 The Measure Tool ! ONLY CoCut Professional ! 

 

Fig. 9: The Measuring Tool  

The measuring tool is used to perform measurements (between any two points) in your 
design. As soon as you click on the Measure icon in your tool box, the cursor changes 
into a bull’s eye. Move the center of the bull’s eye to the first point, i.e. the point from 
which you intend to measure.  
 
While holding down the left mouse button, drag the bull’s eye to the second point, i.e. the 
end-point of the distance you are measuring. A guideline provides a visual connection 
between the two points. 
 
Note: If you hold down the SHIFT key during this procedure, the measuring can be 
limited in a horizontal or vertical direction. This makes it easier to measure straight lines 
accurately. 
 

 

Fig. 10: The Measure Dialog Box 

The Length box indicates the result of your measurement. To change this value, click on 
the text box and enter the new length. You can also make changes to the Percentage 
box below.  
 
The dialog box provides additional information such as the Angle of the line you 
measured, the Width of the object you measured and the Difference in Height 
between the first (beginning) and second (end) point. 
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Clicking on the  button opens the Professional Cut dialog box. 

2.5 The CoCut Professional Objects AttributesToolbar  

 G 
 
The Object Attributes toolbar can be turned on and off via Object Attributes in the 
Window menu or by pressing the G key. 
 

 

Fig.11: CoCut Professional Object Attributes Toolbar 

The Object Attributes toolbar permits you to modify the Size and Position of your 
objects, Skew/Rotate them or Duplicate them horizontally or vertically at freely defined 
intervals. 
 
The Object Attributes... tool bar contains all the functions most frequently required and 
considerably speeds up the work on your job. 
 
In the X and Y boxes you can enter the horizontal and vertical coordinates relatively and 
absolutely in relation to the reference point. 
 
Absolute and Relative Positions 
The absolute position means the real X and Y coordinates of the object’s point of 
reference. 
 
Reference Point 
When the object is selected, the reference points are shown as black squares. These 
squares correspond to the circles in the Object Attributes toolbar.  
 
Note: The center of the selected object is not marked as a point of reference. 
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Fig. 12: Object Center and Point of Reference 

 

Fig. 13: Example of Absolute Coordinates  

If you execute the Relative Position command, the circles are shown in gray, which 
means that they are no longer active. You should set the required point of reference for 
repositioning the circles before activating them.  
 

 

Fig. 14: Example of Relative Coordinates 

In the example (Fig. 14) X and Y values of 50mm (1.96 ins) were entered.  
The value of 60mm (2.36 ins) was entered for the relative coordinates to the reference 
point, i.e. the reference point was moved 60mm (2.36 ins) both horizontally and vertically. 
This results in a new absolute value of 110mm (4.33ins) for the X and Y coordinates.  

1

        center of selected object  

1
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In the Height and Width boxes you can enter the height and width of one or all selected 
objects as numbers or percentages. 
 
If you click the All Objects button, the values you enter will apply to all objects.  
The two fields are linked to each other, i.e. if the width is changed, the height will also be 
modified by the amount typed.  
 
If you deactivate the link between length and width, you have the possibility to alter the 
Height and Width separately. 
 

 

Fig. 15: Connection between Length and Width Deactivated  

The Skew/Rotate Tool in the Object Attributes Toolbar ! ONLY 
CoCut Professional ! 

 

Fig.16: The Skew/Rotate Tool  

If you click on the Skew/Rotate icon, the following dialog box appears: 
 

 

Fig. 17: The Skew Dialog Box 
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Fig. 18 :Objects in the Skew/Rotate Mode 

You can rotate your object by moving your mouse cursor to the round arrows at the 
corners of the object and keeping it held down. When the object has been rotated, its 
position will be shown by a dotted blue line. You can see the exact amount of the rotation 
in the status bar on the bottom left of the screen near the mouse coordinates. 
 
A positive value rotates objects clockwise, a negative value counter-clockwise. 
If you click on one the straight double arrows while holding down the left mouse button, 
your object is skewed to the left and right and upwards and downwards. The sides you 
click on will be moved, whereas the ones opposite remain the same.  
 
If you execute the Relative Angle command, the relative angle will be shown when the 
object is rotated or skewed. 
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The Multi-Copy Tool in the Object Attributes Toolbar 

 

Fig. 19: The Multi-Copy Icon 

A click with the left mouse button on the Multi-Copy icon opens the following dialog 
box: 
 

 

Fig. 20: The Duplicate Dialog Box 

Number X 
You can enter the number of duplicates in a horizontal direction in this box. The arrows to 
the right of the box indicate the direction (right/left) in which the objects are to 
duplicated. 
 
Number Y 
You can enter the number of duplicates in a vertical direction in this box. The arrows to 
the right of the box indicate the direction (upward/downward) in which the objects are to 
be duplicated. 
 
X Offset 
You can enter the distance you wish to have between the duplicates in a horizontal 
direction in this box.  
 
Y Offset 
You can enter the distance you wish to have between the duplicates in a vertical direction 
in this box.  
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If you execute the Select Objects command, all your objects will be automatically 
selected after they have been duplicated.  
 
If you execute the Fill Worksheet command, the specified working area will be 
automatically filled with the previously selected objects. 
 
The Create Clone tool can be used to save storage space, i.e. when an object is cloned, 
only the data of the original is saved but not the data of the clone. 
If the original object is modified, i.e. provided with pencil attributes such as fountain fills, 
the changes will automatically apply to all clones of the original object.  
 
Note: Artwork files cannot be cloned. 
 
Example:  
A customer has given you an order to produce 100 of the same sticker, with 5 stickers 
twice the size of the other 90. 
You load the vector template for the job to CoCut Professional, select the template and 

click on the  (Multi-Copy) button. Execute the Create Clone command In the 
Duplicate dialog box and enter the desired number of clones and the horizontal and 
vertical offsets. 
 
The clones will be created when you click on the OK button. Clones are represented with 
dotted blue lines in CoCut Professional. Now select the five clones which are to be cut 
twice the size and drag them to the desired size. Once you have modified the clones, the 
objects will appear in their original color again. 
 
Note: If you modify the size of a clone, it will become an original again. 
 
If you execute the Group Result command, the objects filling the worksheet or the 
clones created will be grouped according to the sequence in which they were created. 
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2.6 The CoCut Professional Color Layerbox ! ONLY CoCut 
Professional ! 

The color layerbox can be used to color objects, define different vinyl colors, select 
objects of specific colors and block certain color lavers or make them invisible. 
  

 

Fig. 21: The CoCut Professional Color Layerbox 

Layers 1 through 6 are predefined and cannot be changed. To make the color layerbox 
reappear either press CTRL+2 or select Show Layerbox in the Settings menu. 
 
The layerbox can be moved at any time by clicking with the left mouse button on the gray 
bar above Pal > or on the small gray area underneath the last layer. The gray frame 
around the color layerbox becomes black and you can move the color layerbox to any 
position you wish on the CoCut Professional desktop with the left mouse button held 
down. 
 
If you click on the PAL button, a popup menu with the following items opens: 
 
Layer Numbers 
If you execute this command, all the layer numbers will be made invisible. 
 
New 
All color layers with a layer number higher than 6 will be deleted. 
 
You can use this command when you want to specify a new color palette individually. 
You can choose layer colors by clicking once with the mouse cursor on the desired color 
and then on the OK button. 
 
Load... 
This command loads previously defined palettes. 
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Save 
This command permits you to save a newly defined or modified default palette on your 
hard disk. 
If this new or modified palette is saved as the default palette, this palette will be used ever 
time you start CoCut Professional. 
 
Save As... 
This command permits you to give the palette a name. 
 
Default 
This command loads the palette supplied as the default for CoCut Professional. It is a 
Mactac table of vinyl colors, which is defined as the default palette with the help of the 
range of colors. 
 
Palette History 
This tool makes it possible to load the last 4 color palettes without having to use the 
various directories. The names of the last 4 color palettes edited appear at the end of the 
color palette menu list. You can open the desired palette by clicking on it with the mouse 
cursor. 
 
By clicking on the Sel icon you can simultaneously select all objects that were created in 
the selected color layer. 
 
By clicking on the New icon and making appropriate selections in the Layer Setup 
dialog box, you can define new color layers. 
 
Double-clicking on one of the layers/colors will assign the color to all previously selected 
objects. A single click with the right mouse button on one of the color layers will open the 
Layer Setup dialog box. 
 
You can also open this dialog box by using the shortcut L. Double-clicking with the left 
mouse button with the CTRL key held down provides the selected object with a 
wireframe in the color currently activated. When the Layer Setup dialog box is open, you 
can use the PAGE UP button to choose and install the next color upwards and the PAGE 
DOWN button for the next color downwards. 
 
When the last color layer in the layerbox is active, a new layer can be added. 
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The Layer Settings Dialog Box ! ONLY CoCut Professional ! 

 

Fig. 22: The Layer Settings Dialog Box 

In the Layer Settings dialog box there is a choice of 3 color models: 
 
1. Cyan, Magenta, Yellow, Black 
2. Red, Green, Blue 
3. Color, Saturation, Brightness 

Attributes 

Locked means that a particular color layer is no longer available for selection. A lock in 
front of the layer color indicates this status. 
 
Invisible makes selected objects disappear from the desktop. In front of the color layer 
that has been defined as invisible, a crossed-out eye indicates this status. 
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Note: You can undo either command at any time when you open the Layer Settings 
dialog box by clicking with the right mouse button on the selected color layer. 

Layer Name 

In the Vinyl Name box you can assign a type of vinyl or a vinyl manufacturer to a color 
layer. 
  
In the Color Number box you can type the name or number belonging to the type of 
vinyl. 
 
Note: The advantage of specifying vinyl names and color numbers is that you can assign 
color layers to all the materials to suit your particular stock. When creaing new designs, 
you can take these materials into consideration, so that the numbers can be seen when 
cutting. You can save a palette for each selection of vinyl or material type which can be 
used when creating new designs. 

Shortcuts in Layer Editing 

The following shortcuts are available for layer editing: 
 
L opens the Layer Setup dialog box 
 
Speed when scrolling in the color layer box: 
 

 SHIFT 10 times 

 CTRL 100 times 

 SHIFT+CTRL 1000 times 
 
Skipping in the Layerbox: 
 
POS1 Skip to the first layer 
ENDE Skip to the last layer 
PAGE up/down Skip over 1/10 of the number of layers 
Cursor up/down Skip to next layer 
 
Advantage of the Page up/down keys: 
While the new layer is being chosen the Layer Settings dialog box remains open and 
the appropriate numbers can be entered directly. 
 
CTRL+Double-click Assigns a selected object an outline in the currently active 

color. 
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Move Single Color Layer 
 
1. Position mouse cursor on desired layer  
2. Keep left mouse button held down  
3. Move the layer to the desired position 
4. Press right mouse button once 
5. The color layer is in the new position 
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2.7 The Print Command ! ONLY CoCut Professional ! 

 

Fig. 23: The Print Icon 

Open the CoCut Professional Print dialog box by selecting Print in the File menu, 

using the shortcut CTRL+P on the keyboard or clicking on the  icon in the toolbox. 
The following window opens: 
 

 

Fig. 24: The CoCut Professional Print Dialog Box 

In the lower right part of the dialog box you will find the Tile option and the Adapt button 
under Output. 
 
The appearance of the Print dialog box changes depending on which button you have 
activated. When the Print dialog box is called up, the Adapt button is automatically 
activated, because objects or graphics cannot be printed in formats exceeding the 
maximum output size of the printer being used. 
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The Adapt Command 

The Adapt command lets you specify the printable area. The values for the printable area 
are shown in the Printing Area box located in the upper right part of the Print dialog 
box.  

The Preview Window in the Adapt Mode 

This window allows you to recheck your job before it is printed. 
The edges of the window are magnetic, that means that when an object nears the edge 
of the page it sticks to the edge of the window. The Snap to Edge command allows you 
to position your objects quickly in the corners or at the edges of pages. 
 
Tip: If you want to turn off the Snap to Edge command, hold down the SHIFT key while 
positioning your objects.  
 
The coordinates appearing below the preview window show the position of the upper left 
corner of the first object in the working area.  

Mouse Functions in the Preview Window (Adapt Mode) 

Clicking once with the right mouse button enlarges the preview window to its maximal 
size.  
The size of the display depends on the selected screen resolution. (800*600, 
1024*768,...). 
If you click again with the right mouse button the original state is restored. 
If you hold down the left mouse button, a dotted black frame appears around the objects 
to be printed. 
This frame always encompasses all objects located on the working area and corresponds 
to the printing area. 

Printing Area and Object 

The items Printing Area and Object are located in the upper right area of the Print 
dialog box. 
 

 

Fig. 25: Printing Area and Object 

Printing Area 
This box shows the height and width of the specified printing area. 
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Object  
This box displays the object(s) to be printed with its/their heights and widths. 
 
Note: The boxes for the percentual enlargement of objects are not active in the Adapt 
mode. 
 
Beneath the Object field, on the right side of the Print dialog box, you will see the 
Printer field. 

Printer 

 

Fig. 26: Choice of Printer 

If you open the combobox in the upper part of the dialog box, you will obtain a list of all 
the printers installed on your system. Select the printer you wish to use. 
 
To make further settings for the printout, click on the Setup button.  
The dialog box which appears is the same as the menu item Attributes in the Printer 
File menu. 
 
Note: The Print dialog box opened by clicking the Setup button depends on the printer 
driver loaded and for this reason is not explained in greater detail here. 
 
You can specify the Page Format (upright/oblong) in the field to the right of the Setup 
button. 

What is to be printed ? 

In the field headed Print Mode there are two comboboxes which you can use to 
determine what is to be printed. 
In the first box you can choose between Objects and Objects with Worksheet. 
 
Objects 
All objects in the working area will be printed. 
 
Objects with Worksheet 
All objects and also the worksheet (black frame) will be printed.  
The company name, the dimensions of the working area and the proportional size of the 
printout will also be printed automatically below the black frame.  
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The following settings are available in the second box: All Objects, Selected Objects, 
Print Color Separations (print in layer sequence), Print Single Layers (colors). 
 
All Objects 
All objects in the working area will be printed. 
 
Selected Objects 
Only selected objects on the working area will be printed.  
 
Printing Color-Separations  
All objects of one color will be printed in the sequence shown.  
 
The color bar (layer order) in the second box contains all the colors (layers) which have 
been used in the working area. The colors will later be printed in this sequence. The 
darkest color is always printed first. 
 
Print Single Colors (Layers) 
The colors listed in the second box are those which have been used for the objects on 
the working area. 
If, for example, there is only a black and a red object in the working area, there will be a 
choice of only two color bars (layers) available.  
 
Ratio 
You can enter the proportion in which the printout should be made in one of two boxes, 
either as a figure or a percentage. The boxes are coupled, i.e. if you enter a figure, the  
 

equivalent percentage will automatically appear in the box . 
and vice versa. 
 
Examples of proportional entries in figures with the corresponding percentages: 
 
Proportion 1 : 1 100.00 % 
Proportion 1 : 2 50.00 % 
Proportion 1 : 3 33.33 % 
Proportion 1 : 4 25.00 % 
 
Center 
If this option is activated, all objects on the working area will be centered.  
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Tile 
If this option is selected, the Print dialog box appears in the Tile mode.  
 
Number of Copies 
In this box you can specify the number (max. 9999) of copies to be printed. 
The Adjust and Tile buttons permit you to switch to and fro between these two modes. 
 
If this option is activated, all objects on the working area will be centered.  
 
Tile 
If this option is selected, the Print dialog box appears in the Tile mode.  
 
Number of Copies 
In this box the number (max. 9999) of copies to be printed can be specified. 
The Adjust and Tile buttons permit you to switch to and fro between these two modes. 
 
1:1 
When this button is activated, all objects on the working area will be displayed in their 
original size. 
 
Adjust 
When this button is activated, the objects in the working area are reduced so that they 
can be shown in their entirety in the preview window.  
 
Print Colored Worksheet 
If you choose this option, your worksheet will be printed with the specified background 
color. 
 
Print Guidelines 
If the job contains guidelines, these will also be printed. 
 
Always Print Black 
This option will automatically be activated when All Objects is selected in the first box 
and Print Color Separations (in layer sequence) or Print Single Colors (single layers) 
is selected in the second box. 
If you want to print the objects in the working area in color, the command must be 
deactivated. 
 
Register/Crop Marks 
This option will automatically be activated when All Objects is selected in the first box 
and Print Color Separations (in layer sequence) or Print Single Colors (single layers) 
is selected in the second box 
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If you do not want the register/crop marks to be printed, the Register/Crop Marks 
button must be deactivated beforehand.  
 
The following table shows all possible combinations for comboboxes 1 and 2 and the 
possible choices of settings in the Adapt mode. 
 

 

Fig. 27: Possible Settings in the Adapt Mode 

Buttons in the Print Dialog Box 

The OK Button 
If you click on this button, the settings made will be transmitted to the printing device. 
 
The Cancel Button 
You can use this button to quit the Print dialog box. 
 
The Help Button 
Clicking on this button starts CoCut Professional online help. 
 
The Setup Button 
Clicking on this button opens the dialog box for setting up your printer. 
 
Note: The Printing dialog box opened by clicking on the Setup button depends on the 
printer driver loaded and for this reason is not explained here.  
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The Tile Mode 

If you switch from the Adjust mode to the Tile mode, the following preview window 
appears: 
 

 

Fig. 28: The Preview Window in the Tile Mode 

In the Tile mode all tiles are displayed. A tile is the part of an object which can be printed 
or cut on the device being addressed. 
 
Break After indicates after which tile (enter the number of the tile) the output should be 
stopped. You can enter the desired horizontal/vertical intersection of the objects to be 
printed in the boxes under Overlap. 
 
If you print using Roll, complete stretches can be printed without any spaces between 
the single tiles. 
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You can only stop the printing of a complete stretch and not of the individual tiles. 
Entering an intersection in the printing direction does not have any effect on this 
operation, as can also be seen from the display of the tile size. 
 
Note: After tiling, the dialog box will not automatically be closed, as it is useful to be able 
to compare the preview directly with output. This also allows you reprint a particular tile 
immediately. 

Mouse Functions in the Preview Window (Tile Mode) 

You can enlarge the tiling view to the size of the screen by clicking once with the right 
mouse button on the tile preview window. A second click with the right mouse button will 
restore the original state.  
Double-clicking with the left mouse button on a tile deactivates the tile, i.e. it is not 
printed.  
If you double-click with the left mouse button while holding down the CTRL key, the tiling 
will be inverted, i.e. the tiles which were previously deactivated will be activated (printed) 
and the tiles which were activated will be deactivated (not printed). 
 
The objects can be moved within the preview window using the mouse. The Snap to 
Edge function activates you to position your objects easily at the edge of the window. 
You can turn off the Snap to Edge function by pressing the SHIFT key.  

Example of Printing in the Tile Mode  

In the following example, the various functions, shortcuts, etc. in the Tile mode are 
explained again in detail. 
 
The Tile mode offers you the possibility of printing in any size, i.e. any artwork, regardless 
of its size, can be printed out on the printer connected to your system. 
To print your artwork, you do not require a printer for printing A2, A1, A0 or even large 
formats.  
 
How is this done? 
The artwork to be printed is divided into as many partitions (tiles) as necessary to be able 
to print it on the printer connected to your system.  
 
The number of tiles necessary depends on the size of the artwork to be printed and the 
output format (A3, A2, etc.) which has been specified.  
 
You can determine the output format using the Setup button in the CoCut Professional 
Print dialog box. The format depends on the printer which is connected to your system.  
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Load any artwork you like to CoCut Professional and open the Print dialog box, either by 
clicking Print in the File menu, by pressing CTRL+P on the keyboard or by using the 
button in the toolbox. 
 
The CoCut Professional Print dialog box will be opened in the Adapt mode. Activate the 
Tile mode by clicking the appropriate button.  
 
The Print dialog box appears as follows: 
 

 

Fig. 29: The Print Dialog Box in the Tile Mode 

In the upper right corner of the dialog box you will see two fields, Tile and Object. The 
Tile field corresponds to the Printing Area box in the Adapt mode.  
 
The other fields in the right half of the Print dialog box behave in the same manner as in 
the Adapt mode.  
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The preview window in the Tile mode shows all the tiles which are required to print out 
the entire artwork. 
Eight pages, for instance, are required to print out the artwork in the example. 
A change in the output format always necessitates an adjustment in the number of tiles.  
 
Beneath the preview window you will find the fields Break After, Tiling and Roll, which 
are explained on Fig. 29 of the manual.  

Vertical and Horizontal Overlap 

The number of tiles increases depending on the number of vertical or horizontal overlaps 
which you have specified. Fig. 30 shows two tiles to be printed without any overlap. 
 

 

Fig. 30: Two Tiles Without Overlap 
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Fig. 31: 3 Tiles With Overlap 

Fig. 31 shows that the number of tiles increases when you use an overlap.  
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Activated and Deactivated Tiles  

An active tile means a tile which is not marked with an X, whereas deactivated tiles are 
always marked with an X.  
 

 

Fig. 32: Deactivated Tile 

Tiles can be deactivated or activated by double-clicking on them with the left mouse 
button, i.e. a tile is deactivated with a double click. A further double click will reactivate it. 
 
You can see from Fig. 32 that tile number 6 is marked with an X. This tile has been 
deactivated and will not be printed. 
In the Tile mode you have a further possibility besides activating or deactivating single 
tiles.  
 
If you hold down the CTRL key while double-clicking on the desired tile with the left 
mouse button, all tiles, except the one. 
On which the mouse cursor is positioned, will be deactivated. 
 
Fig. 33 and Fig. 34 illustrate this. 
 

 

Fig. 33: 8 Tiles Active (Mouse Cursor is on Tile 6) 
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Fig. 34: Tiles 1, 2, 3, 5, 7 u. 8 Deactivated, Tile 6 Activated 

Advantage of deactivating tiles: 
When your objects are arranged, tiles without objects (empty tiles) may be created, which 
would result in a blank page being printed.  
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2.8 The Cut Command  

This command allows you to activate the module for cutting and drawing your job data. 
The first time you call up this dialog box, another dialog box will first be opened for 
setting up the plotter driver and the cutting port. 

The CoCut Professional Plotter Setup Dialog Box (Local Potter) 

 

Fig. 35: Dialog Box for Cutting Plotter and Port Setup 

General  

Choose your plotter driver from the area of the dialog box entitled General. Click once 
on the arrow pointing downwards and a selection window will open, in which all the 
machine drivers available to CoCut Professional are listed. 
 
After you have made your selection, the driver chosen will be shown on the left of the box. 
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If you do not want to use an existing plotter but install a new one, the name of the new 
driver can be typed in this box. 
 
If you execute the command Activate As Server, the cutting plotter will be selected as 
plot server and can be used by another plot manager for cutting. 
 
It is a characteristic of a cutting plotter that it must be assigned a driver to prepare the 
data for cutting. On the computer on which you are running the plot manager the job data 
will be converted into machine data with the help of a driver. 
The cutting of the machine data can be done in different ways: 

Port Types 

Local Ports 

By local ports are to be understood the ports which are located directly on your 
computer (COM1, COM2, ...LPT1, LPT2, ...). 

Why Use a Serial Plotter Drive ? 

The serial RS 232 port is the link for data exchange between the cutting plotter and the 
host computer. 
The host computer calculates the necessary plotting data decentrally.  
Two-way or bidirectional communication takes place between the host computer and 
the cutting plotter via a hardware handshake. There is a separate data lead for this 
handshake in the original cable supplied by the plotter manufacturer. The centronics port, 
i.e. the parallel (printer) port, only permits one-way or unidirectional communication 
between the host computer and plotter.  
The cutting plotter can receive, but not cut, data using this port. Thus, when using this 
port, it not possible to specify the vinyl width, vary the stabbing pressure or reduce the 
cutting speed.  
 
Only one port at a time can be active, in this case the plotter, as it receives the data first. 
 
Besides this purely technical difference, there is another important reason, which is the 
different distribution of resources with computers using MS Windows 3.xx. 
 
Whereas serial drive lets you go on working during plotting, the computer is blocked all 
the time during plotting when parallel drive is used.  
In this case serial drive means higher productivity.  
 
Clicking on the Settings button opens a dialog box for configuring the port. The settings 
made apply for the whole system. 
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Fig. 36: Dialog Box for Configuring the Port 

Note: With serial drive you must make sure that the baud rate (bits per second) is the 
same on the computer and the plotter, as otherwise they cannot communicate with each 
other. 
 
USB Plotters 
All the currently connected USB plotters are listed here. 
 
TCP/IP 
Here you must enter the TCP/IP address and port number for cutting. 
 
Spooler 
Here you can select a Windows printer driver. 
 
Click on the OK button to confirm the settings made in the dialog box. If you click on 
Cancel the settings will not be adopted. 
 
Note: Next time you recall the Cut dialog box, it will be opened directly with the 
previously installed machine driver. 
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The CoCut Professional Cut Dialog Box 

 

Fig. 37: The CoCut Professional Cut Dialog Box 

Output 

In the part of the Cut dialog box entitled Output are to be found all the selection boxes 
and settings which are directly connected to the plotter. 
 
After Plotter the previously specified plotter will be shown. 

If you want to select another plotter, you must click on the  button. Then a selection 
window will open in which all previously installed plotters are listed. If you click on the 

 button, you will have a choice of three further  
items. 
 
Choose from the Mode/Tool list box if you want to cut, draw or pounce (perforate vinyl, 
e.g. for painter‘s stencils). 
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In the Material box choose the material to be cut. This box is connected to a material 
databank which needs to be filled, i.e. the data for the various types of vinyl are stored in 
this databank. 
 
Thus, for example, the settings for pressure, speed/velocity and width may be different 
for normal vinyl than for flock or metal foils. 
These values have to be entered individually, as they depend on the material and the 
machine you are using.  
 
The range of values are described in your plotter manual.  
For example, the maximum speed is 60 cm/sec, i.e. 60 should be entered under 
Speed/Velocity. Other plotter manufacturers use mm/sec as unit of measurement. In 
this case a three-digit figure has to be entered, e.g. 150. 
 

Clicking on the  button opens the following Popup menu: 
 

 

Fig. 38: Popup Menu of the Material button 

You can add a new set of data to the material databank by clicking on Add. 
 
If you select the menu item Save Material Data, the previously entered or modified 
values will be written into the databank. 
 
If you select the meu item Mode/Tool Default, the values stored in the databank for this 
tool will be used. If you want to modify the values specified, you must position the mouse 
cursor in the the appropriate boxes and enter a different value. 
 
If Material Default is selected, the values stored in the databank for this material will be 
used. If you want to modify the values specified, you must position the mouse cursor in 
the the appropriate boxes and enter a different value. 
 
With a large number of cutting plotters the Read Back button indicates the height of the 
plottable area so that the value for Width does not have to be entered manually. 
If you are using a plotter which does not offer this option, no value or a zero will be 
indicated. 
 
In the Number of Copies box you can specify how often the selected objects are to be 
cut. After cutting, this value will be automatically reset to 1. 
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Stack Offset lets you define whether the copies are to be stacked vertically. This option 
can only be activated if it is possible to cut the selected object more than once one above 
another.  
 
In the stack preview the first object will be displayed in its “normal“ state. Every further 
object in the stack will be shown with a black square containing an X. 
 

 

Fig. 39: Objects in the Stack Preview 

Note: When this option is selected, the lower part of the cut dialog box shows how often 
the images in the job will fit one above another and how many meters of vinyl will be 
needed. 
 
Weed Border allows you to specify whether a rectangle is to be cut around the plot and 
at what distance so as to make it easier to strip or weed the vinyl. 
 
With Segment Offset you can specify the horizontal distance between single 
segments. 
 
If you select the Sort function, all objects located on the working area will be sorted in a 
horizontal direction when they are cut.  
 

 

Fig. 40: The Sort Function in the Cut Dialog Box 

In Fig. 40 you can see 6 objects which have been created in numerical order. 
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First object 1 was created, then object 2, etc. If the Sort function is not active, first object 
1, then object 2, etc. will be cut, i.e. long distances will have to be covered when cutting. 
This can cause the vinyl to become displaced and takes too much time.  
 
If Sort is activated, first object 3, then 6, then 5, etc. will be cut. With this variation, the 
plotter covers the shortest distance possible.  
 
If the you execute the Stack Processing command, all the jobs will be processed one 
after another without any break. 
 
If your artwork is too big for cutting, CoCut Professional will divide it into as many 
segments as are necessary for it to be cut in its entirety. 
If you select the option Wait after Segment the cutting procedure will be paused after 
each segment and the vinyl can be repositioned if necessary. 
 
Note: This function is not suitable for plotters which have a small cutting width or for 
flatbed plotters. 
 

 

Fig. 41: Example of Segmentation (Cutting Width 1.50m/59 ins) 

The physical zero point (0/0) of the plotter or router can be set using the Sheet Origin 
function. 
If this function is turned off, CoCut Professional automatically chooses the physical zero 
point as the starting point for cutting or routing.  
 

 

Fig. 42: Sheet Origin Not Active 

If Sheet Origin is activated, the physical zero point is moved by the amount of the offset 
coordinates of the point of reference. 
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The point of reference coordinates correspond to the position of the lower left corner of 
the object to be cut on the CoCut Professional working area. 
 

 

Fig. 43: Sheet Origin Active 

If you click the Save Settings button, all values which you previously entered in the Cut 
dialog box will be adopted and transmitted to the plotter which is currently active. 
 
If the checkbox Output to File is activated, the output data will be sent to a file specified 
by you and saved on your hard drive. 
 
With Origin you have a choice of two options. If you select Do Not Fix, the physical zero 
point will be taken as the new point of origin after cutting. 
 
If you select New Origin, the plotter will run in a horizontal direction to a specified 
distance behind the object last cut and this position will be the new point of origin.  
 
In the Accuracy selection box there is a choice of the following settings: 
Very low, low, normal, high and very high. Normal is the default setting. 
 
The Accuracy command specifies how many vector part pieces an object should consist 
of. The more nodes / vectors are set, the more accurately an object will be cut. However, 
this only plays a part with objects whose size is measured in tenths of a millimeter. All 
other sizes of objects are automatically calculated by CoCut Professional and the optimal 
number of nodes set for subsequent cutting.  

Color Separation in Cutting  

Besides the cutting commands All Objects and Selected Objects, CoCut Professional 
also allows you to cut single colors or sequences of colors. 
The list box where you can make your selection is entitled Cut Mode. 
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Every color used in your design appears in the Cut Mode list with a number which 
clearly identifies each color layer. 
Two horizontal color bars also appear in this list box.  
These color bars show the sequence in which the color layers will be cut. The color layer 
appearing first on the left will be cut first, i.e. before you start cutting, you must load your 
plotter with vinyl of this color. 
After the data of one color layer have been transmitted to the plotter, a Cutting Plotter 

icon ( ).appears in the status bar. 
A double-click on this icon activates the Job Control. If you position the mouse cursor on 
the icon and click with the right mouse button, a popup menu will appear where you can 
close the Plot Manager or the Plot Manager version can be shown. 
 
In the Job Control the color layers not yet cut appear in the sequence in which they were 
selected.  
 
You can modify the sequence of colors at any time, delete single layers or cancel the 
whole job. 
 
First load the plotter with the material which is in the first position in the stack. Then click 
the Continue Cutting button. Repeat this procedure until all the colors have been cut. 
 
Note: For cutting color separations please use the cutting register marks from the 
drawing tools. The register marks will be cut in the same place on the vinyl regardless of 
color. This helps you to mount the various vinyl colors later. 
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Install Network Plotter ! ONLY CoCut Professional ! 

If you select this menu item, the following dialog box opens: 
 

 

Fig. 44: Dialog Box for Installing the Plot Server 

A network plotter permits you to cut CoCut Professional jobs on a Plot Manager running 
on another computer. Unlike with a “normal“ plotter, the data are not converted into 
machine data but transmitted in their original state to the plot server. 
 
Type the name of the plotter in the input box.  
 
In the field entitled Select Server enter the TCP/IP address for a TCP/IP connection or 
the name of the computer to be used. 
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If the connection is to be established via the network, you must specify the data for 
configuring the plot server here- 
 
If you click on the Update button, the server plotters will be read. 
The server plotter cannot be chosen until the server has been selected, as only then are 
the server plotters available. 
 
Note: Enter the driver used by the server for this plotter in the Driver box.. This driver 
must also be available locally. 
 
The Info box displays information relating to the active driver. 

The Cut Preview Window 

The Cut Preview window is automatically opened when you click the Cut button. 
 

 

Fig. 45: The Cut Preview Window in the CoCut Professional Cut Dialog Box 

The various functions available to you in this dialog box are explained in detail in the 
following sections.  
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The following information about the job to be cut is shown in the Cut Preview window 
status bar: 
 
Wireframe, fill, width and height, group or combination and the maximum amount of vinyl 
used in square meters and continuous meters.  
 
When the Cut menu is selected, the data are transmitted to the cutting plotter.  
 
Note: If the job to be cut is located to the left of, above or below the vinyl preview 
window and the Cut menu is activated, you will be automatically informed that the objects 
to be cut are outside the cutting area. 
 
The ESC key allows you to close the Cut Preview dialog box and return to the CoCut 
Professional working area.  

The Options Menu 

The Rotate Axis Command 

This command is used to rotate objects by 90°.  
 
You need this option regularly if you want to adjust your objects quickly to the running 
direction of the vinyl. 
 
Note: The A key also performs this command. 
 

 

Fig. 46: Example of Axis Rotation  
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The Horizontal (X) and Vertical (Y) Mirror Command  

The X Mirror command mirrors all selected objects on the horizontal axis. The Y Mirror 
command mirrors all selected objects on the vertical axis. 
 

 

Fig. 47: Example of the Mirror Command 

The Optimize Output Command 

When you click this menu item, the dialog box for optimizing the use of the vinyl opens. 
 

 

Fig. 48: Optimize Output Dialog Box  

This function ensures that all the objects are arranged in such a way that they take up as 
little space as possible on the vinyl. 
 
The following options are available to you in this dialog box:  
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Weed Border  
If you check this option, a weed border will be cut automatically around your job to 
facilitate weeding. Enter a value for the distance at which you would like to have the weed 
border cut. 
 
Rotate All Objects to the Shorter Side  
All the objects are rotated so that the shorter side is at the bottom. 
 
Rotate as Needed 
During the output optimizing process, the objects are rotated in such a way that they are 
in the best position for cutting.  
 
Include Bitmaps 
Normally bitmaps and groups containing bitmaps are not optimized. 
You can use this option if you wish to optimize bitmaps. 
 
Only Selected Objects 
Only selected objects will be optimized. This option can be used, for example, to optimize 
in layers (by colors). 
 
Maximum Output Optimization 
If you select this option, two further boxes will appear in the Optimize Output dialog 
box.  
 

 

Fig. 49: Additional Fields in the Maximum Output Optimization Option  

Maximum Output Optimization computes all the possible combinations from the 
Final Optimization ... and Permutation Depth fields. 
 
This calculation may take quite a long time if the values are large, as all the possible 
combinations from the two boxes are computed and compared. 
 
Note: Normally no more than 10-15 objects with a permutation depth of 6 at maximum 
should be set up. When optimization has taken place, one or more of the objects will 
always be rotated.  

The Recalculate Command 

This command closes the preview window and reopens the CoCut Professional cut 
dialog box. 



 
 
 

 

HOW TO WORK WITH COCUT PROFESSIONAL Chapter 2 

61

The Original Display Command 

Clicking on this menu item restores the cut preview window to its original state, i.e. if the 
object in the preview window has, for example, been duplicated or repositioned, the 
preview now appears as it was after you had clicked on the Cut button.  

Weeding Lines 

Example of Adding Weeding Lines 
 

 

Fig. 50: Addition of Horizontal/Vertical Weeding Lines 

You can see in the figure above that there is only a weed border around the objects to be 
cut. 
Especially when the objects are small, this is often insufficient for weeding them quickly 
and easily.  
 
In the cut preview window you have three possibilities of adding horizontal/vertical 
weeding lines. 
 
Note: It is only possible to add weeding lines when this command is activated in the Cut 
dialog box. 
 
1. Manual 
Position the mouse cursor on the weeding frame surrounding the objects.  
 
The mouse cursor turns into a double arrow. Now drag the horizontal/vertical segment 
line to the position where you wish to make a segment. Repeat the procedure until you 
have added all the segment lines you wish.  
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2. Via the Options Menu 
Open the Options menu and select Horizontal Weeding Lines or Vertical Weeding 
Lines. 
 
The first weeding line is added horizontally or vertically in the centre of the object to be 
cut. 
 

 

Fig. 51: Example of Adding Horizontal/Vertical Segment Lines via the Options Menu 

It can be seen in the figure above that if you keep on clicking one of these two menu 
items the segments created will be divided in the center by further segment lines.  
 
3. Via the Shortcuts h or v (see point 2) 
In the figure below we can see how an object is prepared for cutting with segment lines. 
 

 

Fig. 52: What Is To Be Cut?  

When the Cut menu is activated, the data is transmitted to the plotter for cutting.  
 
Note: If the job to be cut is situated to the left of, above or below the material preview 
when the Cut menu is activated, you will automatically be informed that the objects to be 
cut are outside the cutting area.  
 
Press the ESC key to quit the Cut Preview dialog box and return to the CoCut 
Professional working area. 
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The View Menu  

The Material Width Command 

If you select this full screen command, the entire working area will be shown. 

The All Objects Command 

This command alters the representation of the vector drawing in such a way that all the 
objects can be seen on the screen. The section is chosen in such a way that the artwork 
is shown as large as is possible with all the objects being visible. 
 
Note: If you keep the SHIFT key held down while peforming this command, only the 
selected objects will be zoomed to the maximum possible size. 

The Show Selected Objects Command 

When you perform this command, only the Selected Objects on the working area will 
be shown in their maximum possible size. You can also use the shortcut SHIFT+F4. 

The Total Area Command 

If you perform this command, a preview of the total vinyl area will be shown. 
The size of the area shown depends on the frame size (Vinyl height * Vinyl width) of the 
output device being addressed (e.g. router or plotter). 
 
If you have selected a driver for a roll plotter in the cut dialog box, a vinyl length of 30 m 
(27 ft) will always be shown in the preview window. 
 
If you chose a driver for a table plotter, for example, in the cut dialog box, the maximal 
width of this table plotter (e.g. Wild TA 10 = 2m/6 ft 8 ins) will be shown as vinyl length. 

Job Sectioning in the Cut Dialog Box 

If the job to be cut exceeds the output width specified (Width box in the cut dialog box), 
the message “Sectioning Job“ appears in the lower part of the cut dialog box. 
 
Explanation: Sectioning means the division of a job into as many parts or sections as 
are necessary to cut the complete job. 
 
When you click on the Cut button, the following dialog box appears: 
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Fig. 53: Sectioning Dialog Box 

When you activate the Optimize Output command, CoCut Professional will divide the 
object into segments of the maximum permissible size. 
 
The Optimize Segments command allows you to create segments of an equal size. 
 
Cut Negative lets you specify that the image should be cut as a “negative”, e.g. for use 
as a template in screen-printing.  
 
The intersections of the segments can be determined in the X and Y Overlap boxes. 
 
To close the dialog box, click on Cancel.  
 
Clicking on OK opens the sectioning preview window, which lets you specify the 
sectioning of your job. 

Modifying Sectioning 

To modify the sectioning, click on the gray sectioning lines and drag them to the desired 
position. CoCut Professional will automatically add new sections, if necessary. 
 
A hook in front of a segment indicates that the segment can be cut. If you deactivate the 
hook by clicking once on the left mouse button, the segment will be deactivated and will 
not be cut.  
 
The menu items in the preview window and the functions of the right mouse button are 
the same as those in the cut dialog box.  
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Exception: You can use the menu item Segment Size to display the size of the 
segment on which the mouse cursor is positioned.. 
 
The status line of the segmenting preview window shows the size of the job to be cut in a 
vertical and horizontal direction and the number of segments.  

2.9 The CoCut Professional Plot Manager 

The Plot Manager has the following tasks: 

Configuring and Reconfiguring Plotters 

With the Plot Manager it is possible to configure or install a plotter. All the information 
necessary for data output, such as driver and port, are combined in a single device. 
 
In CoCut Professional these plotters can then be used for pltting artwork. It is possible to 
output on several plotters at the same time. 

Monitoring the Job Output Process 

The output of the various plotters can be monitored with the Plot Manager, e.g. plotting 
can be paused or stopped and the sequence of jobs changed. 

Data Output on Local Ports 

The serial and parallel ports on your computer can be detected by the Plot Manager and 
used for plotting data. 

Managing Hot Folders ! ONLY CoCut Professional ! 

The management of hot folders is a tool which operates independently of CoCut 
Professional. A hot folder is a directory which is monitored by the Plot Manager. When a 
file is copied to this folder, the Plot Manager automatically performs certain configurable 
commands. 

Plot Server Function ! ONLY CoCut 
Professional ! 

The Plot Manager can make plotters available for other Plot Managers to use. This makes 
it possible to separate design and plotting workstations. 
You start the Plot Manager by double-clicking on the icon in the start bar located at the 
bottom right of your screen. 
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Fig. 54: The CoCut Professional Plot Manager Dialog Box 

Plotter Folders 

Each plotter has three plotter folders for showing jobs: 
 
Note: Jobs also include plots performed from hot folders or on local ports. 
 
Plotter Folder 1  
 

 Active Jobs 
All jobs to be plotted will be collected in this folder as soon as the machine is ready. 
When one job has been finished, the next one will be started. If the command “Show 
message window before plotting job“ is activated, a message dialog box will be shown 
before the job is plotted. 
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Plotter Folder 2 

 Passive Jobs 
When the plotter is stopped temporarily, all the jobs to be plotted will be moved to this 
folder. 
 
Plotter Folder 3 

 Plotted Jobs 
The jobs already plotted are saved in this folder. The number of jobs saved can be 
specified in the Options dialog box of your plotter. When the number of jobs saved has 
been reached, the next job to be saved will replace the oldest one in the folder. 

Job Commands 

The commands vary according to the plotter folder and type of plotter as well as the job 
status. 
 
Note: You can execute the commands via a context menu. 

Commands for Jobs on Local Plotters: 

Active Jobs 
When the job is just being plotted: 
 
Stop plot Plotting of the data will be stopped temporarily. The job will be 

marked with a red dot    . 
Stopped Jobs 
Continue Plotting will continue. 
  
Make Job Passive The job will be deleted from the list of active jobs and added to 

the Passive Jobs folder. 
  
Delete Job The job will be deleted. 

 
Passive Jobs 
Activate Job The job will be deleted from the list of passive jobs and added 

to the list of active jobs. 
 
Delete Job The job will be deleted.   
 
Message:  You can type a message text for this job. The information will be 

displayed when the job is to be plotted or selected. 
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Plotted Jobs 
Activate Job The job will be deleted from the list of plotted jobs and added to 
  the folder of passive or active jobs depending on the plotter  
  setting. 
  
Delete Job The job will be deleted. 
 
Plot to File  Here you can specify if the job is to plotted to a file. 

Commands for Jobs on Network Plotters ! ONLY CoCut Professional ! 

Active Jobs 
No commands  
 
Passive Jobs 
Activate Job The job will be deleted from the list of passive jobs and added 

to the list of active jobs. 
 
Delete Job The job will be deleted. 
 
Message: You can type a message text for this job. The information will be 

displayed when the job is to be plotted or selected. 

 
Plotted Jobs 
Activate Job  The job will be deleted from the list of plotted jobs and added to 

the folder of passive or active jobs depending on the plotter 
setting.  

  
Delete Job The job will be deleted. 

Commands for Jobs in Hot Folders: ! ONLY CoCut Professional ! 

Active Jobs 
No commands   
 
Passive Jobs 
Activate Job The job will be deleted from the list of passive jobs and added 

to the list of active jobs. 
 
Delete Job The job will be deleted. 
 
Message:  You can type a message text for this job. The information will be 

displayed when the job is to be plotted or selected. 
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Plotted Jobs 
Activate Job   The job will be deleted from the list of plotted jobs and added to 
  the folder of passive or active jobs depending on the plotter  
  setting.  
  
Delete Job   The job will be deleted. 

Commands for Jobs on Local Ports: 

Active Jobs 
When the job is just being plotted: 
 
Stop plot Plotting of the data will be stopped temporarily. The job will be 

marked with a red dot    . 
Stopped Jobs 
Continue    Plotting will continue. 
  
Make Job Passive  The job will be deleted from the list of active jobs and added to 

the Passive Jobs folder. 
  
Delete Job The job will be deleted. 
 
Passive Jobs 
Activate Job The job will be deleted from the list of passive jobs and added 

to the list of active jobs. 
 
Delete Job The job will be deleted. 
 
Message:  You can type a message text for this job. The information will be 

displayed when the job is to be plotted or selected. 
  
Plotted Jobs 
Activate Job    The job will be deleted from the list of plotted jobs and added to 
  the folder of passive or active jobs depending on the plotter  
  setting. 
  
Delete Job    The job will be deleted. 
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Plot Manager Setup 

 
Fig. 55: The Plot-Manager Setup Dialog Box 

If you execute the Plot Manager Always in Front command, the Plot Manager will 
always be in the foreground. 
 
If you execute the Activate Direct Help command, a short description of an item in the 
dialog box will appear when the mouse cursor is moved to this item. 
 
If you execute the Show Job Preview command, a preview image of the data to be 
plotted will be shown. 

Command Line Entry 

When the Plot Manager is started without a command line entry, it searches all plotters 
for jobs to be plotted. If a job is found, it will be plotted. 
 
The Plot Manager shuts down if no job is found or all the jobs have been plotted. If 
!SPOOL! is entered at the beginning in the command line, the Plot Manager stays active.  
 
It must be shut down manually by clicking with the right mouse button on the Plot 
Manager icon in the taskbar. 
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Hot Folders ! ONLY CoCut Professional ! 

You can use a hot folder for monitoring a directory. When a file is copied to the 
monitored directory, one of the following actions will be peformed according to the 
setting made: 
 

 

Fig. 56: Dialog Box for Plotter Setup for a Hot Folder 

COM/LPT: The file will be plotted on a local serial or parallel port. 
 
USB:  The file will be plotted on a USB plotter. A USB plotter is only  
  displayed when it is connected to your computer. 
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TCP/IP: The file will be sent to a TCP/IP address. For some addresses you 
also have to enter the correct port number. 

Spooler: The file will be plotted with a printer driver. 
  
File:  The file will be copied to the plot directory. Any existing file of the 

same name will be overwritten. 
The input file will be deleted once the action has been performed. 

 
In addition, another program can be started to continue editing the input file which is just 
being edited. The file name will be marked with the % symbol. 
 
Note: If “File“ is specified for plotting, the program will start after the copying process. 
In all other cases the program will start before plotting. 

Common Difficulties Encountered During the Cutting Process 

a) Vinyl Bunches Up 

Result: 
The blade causes the vinyl to shift, leaving gaps in the contour.  
 
Remedy: 
When loading the material, make sure it is held tightly and evenly to avoid any wrinkles. 

b) Excessive Cutting Speed 

Result: 
Small characters or parts of your design, such as serifs, centers, dots, etc. are lifted off 
and separated from the liner. 
 
Remedy: 
Reduce the cutting speed and possibly the cutting pressure.  

c) Excessive Cutting Pressure 

Result: 
The liner is cut or scored, small characters or parts are lifted off and separated from the 
liner, pieces of liner stick to your letters. Weeding becomes much more difficult.  
 
Remedy: 
Reduce the cutting pressure and possibly the cutting depth as well.  
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d) Insufficient Cutting Pressure 

Result: 
The vinyl and adhesive are not cut all the way through. Weeding becomes very difficult, if 
not impossible. 
 
Remedy: 
Increase the cutting pressure and possibly the cutting depth as well. 

e) Excessive Cutting Depth 

Result: 
Vinyl, adhesive and liner are cut all the way through. Result is unusable. 
 
Remedy: 
Decrease the cutting depth.  

f) Dull Cutting Blade  

Result: 
Only the vinyl is cut through; the adhesive remains more or less intact. When cutting 
standard vinyl, the life of the cutting blade should be fairly long. When cutting thicker, 
tougher materials, such as reflectives or sandblast stencil, the blade will dull much faster. 
 
Remedy: 
Replace the blade. 

g) Small Graphics Separate from Liner  

Result: 
Weeding becomes nearly impossible. Small parts of the graphic, such as serifs, centers, 
or dots stick to adjacent vinyl and cannot be removed.  
As a general rule, the smaller the graphics you are cutting, the thinner the vinyl must be 
and the stronger the adhesive to held everything in place.  
 
Remedy: 
Decrease the cutting speed and possibly the cutting pressure as much as necessary.  

h) Liner Cut Through 

Result: 
Parts of the liner stick to the letters; weeding becomes very difficult, if not impossible. 
 
Remedy: 
Reduce the cutting depth and possibly the cutting pressure as well. 
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CMX Import ! ONLY CoCut Professional ! 

You can import CMX files to CoCut Professional with the Windows Explorer or via 
Windows 98 using drag & drop.  
 
Note: Drag & drop is also possible with EPS and bitmap files. 
 
Procedure: 
Arrange the program windows (e.g. CorelDRAW and CoCut Professional) on your 
screen so that the two windows are next to each other or one below the other. 
When you click on the task bar with the right mouse button, a context-sensitive menu 
opens, offering you various window arrangements. 
Choose the object(s) you want to import to CoCut Professional and simply drag them to 
the CoCut Professional working area.  
It is also possible to import CMX files via the CoCut Professional dialog box. 
Objects can also be imported to CoCut Professional from CorelDRAW 6, 7, 8, 9, 10 & 
11 via the clipboard. 
Single objects can be selected in CorelDRAW and imported to CoCut Professional 
using drag & drop. 

Description of the Right Mouse Button Menu ! ONLY CoCut 
Professional ! 

The object-sensitive menu that can be opened using the right mouse button makes it 
much easier and faster to work with CoCut Professional. 
The menu items Refresh Screen, Import, Export and Working Area are available as 
defaults. 
 

 

Fig. 57: Examples for Right Mouse Buttons Commands 
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In addition to these, further menu items will appear depending on how the objects are 
positioned on your working area (combined, grouped). 
 
Additional items are: 
 
Working Area Right mouse button 
 
1. One object Outline 
 Combine 
 Import 
 Export 
 
2. More than one object Group 
 
3. Grouped objects Ungroup 
 
4. Combined objects Break apart 

2.10 Access to RCS ONLINE 

For this you need acess to the internet, e.g. via AOL or an internet provider. 
 
Advantages of access via the internet:  
 
You only have to pay the charges to your internet provider (usually local charges). If you 
already have access to the internet, no configuration is necessary to connect to us. 
 
Open your www browser and type our address:  
 
http://www.eurosystems.lu or http://www.cocut.com 
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3. Reference Section 
Menu items in chronological order: 

3.1 The File Menu ! ONLY CoCut Professional ! 

The Job Manager Command 

The Job Manager command starts the visual file manager of CoCut Professional. 

Introduction 

The Job Manager is a powerful tool for managing files. At last you will know what files 
you can find where and what files belong to which customers. With the Job Manager 
this is absolutely no problem!  
 
Finding old jobs used to involve time-consuming, often fruitless searches but is now 
quick and easy with the Job Manager. 
 
With the Job Manager it is possible to manage CoCut Professional or EuroCUT jobs, 
CorelDRAW files or to create an archive of any kind of graphics, text or spreadsheet 
formats (e.g. Excel). 
 
The most important commands of the Job Manager can be executed using the context-
sensitive menu of the right mouse button 
or the shortcuts. This guarantees that you can work rapidly and comfortably with the 
Job Manager. 
 
The Job Manager allows you to search for files in selected directories and with editable 
enquiry masks. 
 
When you create a new job or edit an existing job and save it in the previously 
specified search paths, the Job Manager displays the job next time you start your 
computer. 
 
The Job Manager can make backups of the artwork data, which can be recorded on a 
CD for your archives. 
When backup is made, a complete version of the Job Manager will be stored at the 
same time so that the artwork data can be used on any computer or network of your 
choice. 
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The Job Manager Desktop and Working Area 

After you have started the Job Manager its desktop and working area appear as 
follows: 
 

 

Fig. 58: The Job Manager Desktop and Working Area 

In the upper part of the desktop you can see the system menu with File Names and 
buttons to Minimize, Maximize and Quit the Job Manager. 
 

 

Fig. 59: System Menu with File Names and Buttons 

Here you will find the Job Manager menus, which will be described in detail later. 
 
The Job Manager symbol bar can be turned on and off by clicking on Symbol Bar in 
the View menu. 
The most important commands for editing data are to be found at the beginning of of 
the bar. After these there is the button for opening the Search dialog box and the tree 
view and tree structure can be turned on and off.  
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Info about... opens a dialog box which shows your Job Manager version, the 
numbers of bitmaps and the storage space required. Clicking on the last button opens 
the Job Manager Help. 
 
Note: If you want more preview images to be shown in the preview window, you can 
turn off the tree view. 
 

 

Fig. 60: The Job Manager Toolbar 

All existing groups of directories and their search paths are displayed in the Directory 
Groups window. When you start the Job Manager for the first time only the EuroCUT 
Jobs group of directories appears in this selection box. 
 
You can make the selection window visible or invisible by clicking on Directory 
Groups in the View menu. 
 
Note: You can also use the context-sensitive menu of the right mouse button to call up 
the most important menu items. 
 
Next to this box there is another selection box with a choice of two possibilities. 
 
If you select File Name and type, for example, the letter a in the field to the right, the Job 
Manager selection goes to the first job beginning with the letter a. 
 
If File Date is selected and, for example, 4 April 2002 specified as the starting date in 
the input box on the right, the Job Manager selection goes to the first job created on this 
date. 
You can make tbis selection window visible or invisible by clicking on Search Mask in 
the View menu. 
 
The directory group window is located on the left beneath the directory group display. All 
Directory Groups and their Search Paths are displayed here and also all Searches. 
 
On the right is the Job Manager Preview Window, in which are displayed the located 
preview images of the files, selected directory groups or search paths. 
 
The Job Manager Search Mask is located in the lower left corner of the desktop. Here 
you can specify and edit your own search masks. 



 

 

REFERENCE SECTIONChapter 3 

79

Note: The search mask is not displayed the first time you start the Job Manager. 
 
You can make the search mask visible or invisible by clicking on Search Mask View in 
the View menu. 
 
When you start the Job Manager the first time there is a choice of two search masks. 
 
Search mask 1: Search by Company 
Sarch Maske 2: Search by Order No. 
 
Company and Order No. are fields from the EuroCUT Job Info. 
 
The Search Path Display shows all existing and newly created search paths.  
 
In the Selection box you can specify the enquiry command for searching the selected 
search path. 
 
You can make the Path Selection visible or invisble by clicking on Path Selection in 
the View menu. 

Switching between Full-Screen and Part-Screen Modes 

The Job Manager window can be switched to different modes. The Job Manager is 

started in full-screen mode as default. You can switch to part-screen . The full-screen 

button then takes on the following appearance:  
 
In the part-screen mode the vertical and horizontal dimensions of the window can be 
modified. 
To do this, move the mouse cursor to the outer edge of the Job Manager window. The 
cursor then turns into a horizontal double arrow.  
Keep the left mouse button held down and modify the size of the Job Manager window 
as you wish. 
 
Note: The Always in Front command is only active in the part-screen mode. 
 
It is especially useful to use the part-screen mode in conjunction with plotting or graphics 
programs. 
 
When the desired graphics program and the Job Manager are open, the Job Manager 
can be positioned on the graphics program working area in such a way that the work with 
the graphics program is not obstructed. 
If the Always in Front command is executed in the Job Manager, the Job Manager will 
always be visible. 
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Advantage: All jobs located in the specified search paths can be dragged to the 
graphics program directly with drag & drop or imported. 
Thus it is no longer necessary to search or open jobs using several dialog boxes. 

Selecting One or Several Preview Images 

You can select a preview image by positioning the mouse cursor on the appropriate 
preview image and pressing the left mouse button. 
 
Several jobs can be selected in two ways 
 
1. Selecting several jobs singly 

Keep the CTRL key pressed down and select the appropriate preview images singly 
one after other with the left mouse button. 

 
2. Selecting several jobs one after another 

Keep the SHIFT key pressed down and select the first and last image of the preview 
images chosen. 

Finding a particular preview image in the Job 
Manager window 

When there is a large number of preview images, it is often difficult to find a particular 
preview image quickly. To do this, there are two possibilities available in the preview 
window: 
 
1. Using the a-z keys: 

When, for example, you press the“a“ key, the first preview image whose file name 
begins with an “a“ will automatically be displayed. 
 

2. Intelligent scroll bar 
 Position the mouse cursor on the Scroll button and keep the left mouse button 

pressed down. If you drag the Scroll button up or down, the name of the currently 
active job will be displayed. After finding the job you were searching for, release the 
mouse button again. The selected job will now be displayed as the first one in the 
upper left corner of the preview window. 

The context-sensitive menu of the right mouse button in the Job 
Manager preview window (mouse cursor on blue background) 

The context menu activates you to access the various functions in the preview window 
quickly. You can open the context menu of he preview window by positioning the mouse 
cursor in the colored area of the preview window and then pressing the right mouse 
button. 
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Fig. 61: The Context Menu in the Preview Window 

Sort 

There is a choice of the following functions in the Sort menu 
 
When you execute the By File Name command, all the preview images will be sorted 
according to their file names.  
 
The file whose name begins with an A is in first position or if there is no file beginning 
with A, then the next letter of the alphabet. 
Example: In a directory there are four files to be sorted according their file names. 
 
Major, Miller, Walton, Williams 
 
As none of the names begins with A, the name beginning with the next letter of the 
alphabet is displayed, in our example Major, followed by Miller, then Walton and 
Williams at the end. 
 
If you execute the By Date command, all the preview images will be sorted according to 
their dates of creation or, if the dates have been changed, according to the date of the 
most recent change. 
 
If you execute the By File Size command, all the preview images will be sorted 
according to their file sizes. 
If you activate the menu item By Directories, all the preview images will be sorted in the 
order in which they are found in the directories of the chosen search path. 
 
Example: The files located in the following search path are to be searched for 
according to the directory sequence. 
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Z:\one\two\three\...  
In the example above the preview images of the files located in directory one will be 
displayed first, then those from directory two, etc... 
 
All above-mentioned menu items can be used in ascending order. If, for example, the 
sort is to be done By File Size and Ascending is executed, all the preview images 
located in this search path will be shown, starting with the smallest. 

Select All 

 CTRL + A 
This command selects all files located in the chosen directory group. 

Unselect All  

This command unselects all files which were previously selected. 

Unselect  

 CTRL + U 
This command unselects all files which were previously selected. 

Reveal Hidden Files 

 CTRL + D 
This command is not active unless you are searching in a directory group for files that do 
not meet the criteria and are thus not displayed. 
 
Example: A directory group contains 30 files. Ten of the file names begin with the letter 
A. The twenty remaining files begin with other letters. Now a search is to be made for all 
files whose names begin with an A. 
 
The ten files beginning with an A are displayed as the result of the search. The other 
twenty files are not shown in the preview window.  
 
If the Reveal Hidden Files command is executed, all files located in this directory 
group will be displayed. 
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The context-sensitive menu of the right mouse button in the Job 
Manager preview window (mouse cursor on an Job) 

The context menu activates you to access the various functions in the preview window 
quickly. You can open the context menu of the preview window by positioning the mouse 
cursor on the colored area of the preview window and then pressing the right mouse 
button. 
 

 

Fig. 62: The Context Menu of the Preview Images in the Preview Window 

Open File 
Opens the file with the application registered for the file format. 
 
Import File 
Imports the file with the application registered for the file format. 
 
Send to... 
Starts the standard email program (if one exists) and prepares an email with the file as 
attachment. 
 
Copy File... 
Copies the selected file(s) to the chosen directory. 
 
Move File... 
Moves the selected file(s) to the chosen directory. 
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Delete File... 
Deletes the selected file(s) and places them in the rubbish bin. The files in the rubbish 
bin can’t be restored once they have been deleted. 
 
Reread Preview Image 
The preview images will be read in again. 
 
Print Preview Image 
The preview image(s) will be printed. 
 
Commands only for EuroCUT jobs: 

Edit Job Info  
 Print Job Info  

The Job Manager Menus 

The File Menu 

The New… Command 

This command opens a new Job Manager file. The Job Manager desktop and working 
area open with their default settings. You will have to redefine search paths, search 
masks and settings.  

The Open… Command 

This command loads files stored on your hard disk or a CD-ROM in the Job Manager 
format (*.jmn) to the Job Manager working area. You can now edit these files as you wish. 

The Save Command 

This command saves your current job. If you have already saved this job, the given file 
name and directory will be maintained. No dialog box will open for selecting a target 
directory but the job will be written directly into the previous directory.  
 
Note: The old version of the job will be overwritten and is no longer retrievable. 
 
The first time you save a job a dialog box opens for selecting the target directory. Here 
you can specify the desired Target Directory for saving the job and the File Name of 
the job. 
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The Save As… Command 

With this command you can save a new file under the name you select in the target 
directory you desire. You can also use this command to change the file name and / or 
the directory of already existing files. 
For example, you may want to save a job composed of parts of an already existing job 
without losing the old version. Then choose the Save As... command and you can save 
the new file under a different name in a new directory. 
You can also use the Save As... command when you want to save the current file on a 
diskette or CD.  

The Search Hard Disks... Command 

This command opens the Job Manager Find Files dialog box. This box activates you to 
find all graphics, text or other files located on your PC or in your network. 
You can search according to the default formats available under Search By... If you 
want to search for other formats, you can enter them in the Job Manager in the Options 
menu under File Formats.  
 

 

Fig. 63: The Job Manager Find Files Dialog Box  
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In the upper part of the dialog box you can find the input box titled Search In..., where 
you can type the directory, the hard disk or the network drive in which you want to 
search. 

If you click the  button to the right of the input box, the dialog box for selecting the 
directory opens. 
 

 

Fig. 64: Dialog Box for Selecting Directory  

Here you can choose the directory or network branch to be searched and confirm your 
choice by clicking the OK button. 

The path or directory selected will now appear in the input box. If you now click on 
the Search button, the specified path will be searched for the previously selected 
formats. The status of the search is shown to the left of the Search button. The 
Search button is not activated unless a format is selected.  

With the  button you can select directories in the manner described above. These 
will be added to the directories you have already typed. 
Clicking on the All Hard Disks button automatically enters all local hard disks in your 
system in the input box.  
 
The selection window entitled Search By can be used to select particular file formats. 
Here you will find all the formats which are available as defaults after the Job Manager 
has been initially installed. If new file formats are added to the Job Manager, they will 
also be shown here and can be selected. You can select a particular format by double-
clicking on it with the left mouse button.  
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You can unselect the previously selected format by double-clicking on it again with the 
left mouse button. 
The three buttons beneath the window can be used for quickly selecting or unselecting 
file formats.  
 
The All button can be used to include all existing formats in your search. 
 
The None button unselects all previously selected formats and the Unselect button 
cancels the selection. 
You start the search by clicking on the Search button. 
 
When the search is completed all the paths found will be shown in the box entitled 
Directories Found. 
 
The files found will be shown displayed sorted according to format, i.e. all TIFF files 
found and their respective paths will be stored under TIFF-Bitmap.  tif. All JPEG files 
and their respective paths will be stored under JPEG Bitmap  .jpg. 
If you now click with the left mouse buttonon the PLUS sign in front of TIFF Bitmap  
.tif, all the directories in which TIFF files were found will be displayed. 
If you now click with the left mouse button on the PLUS sign in front of JPEG Bitmap  
.jpg, all the directories in which JPEG files were found will be displayed. 
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Fig. 65: The Job Manager Find Files Dialog Box  

Fig. 65 shows the Find Files dialog box during a search. The Search button is replaced 
by the Cancel button during a search. The search status display is located to the left of 
this button. 
If the search is canceled, only the directory groups and paths found before cancelation 
will be shown. 
 
In Fig. 66 you can see in the window entitled Directories Found that after a successful 
search two groups of directories (JPEG Bitmap  .jpg and TIF Bitmap  .tif) are 
displayed. You can recognize groups by the PLUS sign in front of the group name.  
 
If you click once with the left mouse button on the PLUS sign in front of JPEG Bitmap  
.jpg, the tree element will open up, showing all the TIFF files and the directories in which 
they are located. 
You can proceed in the same way with the JPEG group of directories or any other 
groups, which will be displayed in the window after a successful search.  
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Fig. 66: Section of the Directories Found Window 

Fig. 66 shows part of the Directories Found window. The TIFF Bitmap Directory and 
its subdirectories are shown in the upper part of the area. 
 
You can select several directories Singly by clicking with the left mouse button on the 
desired directories with the CTRL key held down. 
 
You can select Several directories at once by moving the mouse cursor to the first 
directory and pressing the left mouse button once. Press down the SHIFT key and keep 
it held down. 
Now select the last directory with the left mouse button and the whole group is selected. 
 
You can now open the context-sensitive menu by pressing the right mouse button. 
 
If you select the first menu item Add to Group another popup menu will open and the 
selected directories can be added to an existing group or saved in a new group. 
Already existing groups will be shown in the lower part of the popup menu. 
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You can give a group a new name by simply typing the desired name in the input line and 
clicking on the OK button. 
The directories will then be added to the window of the groups of directories in the Job 
Manager under this name. 
 
If you select the menu item Add Automatically, a new directory group will be 
automatically added containing the same directory, e.g. if one or several directories from 
the TIFF Bitmap group are selected and Add Automatically is activated, a new 
directory group called TIFF Bitmap will be created and the selected directories will be 
copied to this group of directories. 
 
Note: The menu item Combine is not active unless at least two directories are selected. 
Only directories located in the same group can be combined. 
 
This command is especially useful when several directories have the same structure. 
In Fig. 66, for example, the first four directories all begin with D:\Order\Peter\... . 
There are various different directories located under the directory named Peter. If you 
select the menu item Combine, these four directories will be combined under the 
directory name D:\Order\Peter\*.* 
 
Note: All the combined directories will be regarded as being a single directory, i.e. when 
later, for example, a search is made for the directory in the main window of the Job 
Manager, it will apply for all the directories combined in D:\Order\Peter\*.* 
The combined directories can no longer be treated singly. 
 
If you click on the Add All button, all the directories found will be added to the Job 
Manager window.  
 
If the you click on the Add Selected button, all selected directories will be added to the 
Job Manager window. 

Printer Setup 

This menu item opens the Job Manager Print dialog box. Here you will see a list of all the 
printers installed on your system. Choose the printer you wish to use. 
Click on the Setup button to make further settings for the printout. 
The dialog box that opens corresponds to the menu item Attributes in the chosen 
printer’s file menu. 
 
Note: The Print dialog box which is opened by clicking on the Setup button depends on 
the printer driver loaded and for this reason in not described further here.  
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Quit 

If you select this menu item the Job Manager will be closed and the most recent changes 
saved. 

The Options Menu 

Add Directory Group 

If you activate this menu item, the following dialog box will open: 
 

 

Fig. 67: Dialog Box for Naming a New Group of Directories 

Enter the name for the new group of directories in the command line entitled Directory 
Group Name and confirm it by clicking on the OK button. 
 
If you click on the Cancel button the name you have typed will not be adopted and no 
new group of directories will be created. 
 
This command is also available in the context menu of the right mouse button. 
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Add Search Path 

If you execute this command the Add Search Path dialog box will open.  
 

 

Fig. 68: Dialog Box for Adding New Search Paths  

The search path is entered in the upper part of the dialog box. To the right of the box 
there is a triangle pointing downwards. If you click on this triangle with the right mouse 
button, all existing search paths will be displayed. 
 

If a different search path from the existing ones is to be entered, click on the  button 
with the right mouse button. 
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The following dialog box will open: 
 

 

Fig. 69: Dialog Box for Selecting Directory 

Choose the directory or branch of the network to be searched and confirm the dialog box 
by clicking on the OK button.  

The path or directory selected now appears in the input box.  
 
Under Files To Be Found: select the format for the search in the previously specified 
directory. The following settings can be made In the field entitled Options: 
 
If you execute the With Subdirectories command, all the subdirectories of the 
previously specified directory will be searched.  
 
Note: Monitor Directory is not active in this case, because only single directories can 
be monitored. 
 
If you execute the Monitor Directory command, the chosen directory will be monitored, 
i.e. when a new file is saved in this directory, the Job Manager will automatically detect it 
and show the new file.  
 
Save CD Name and CD Label are not active unless files from a CD are to be searched 
for.  
 



 

 

REFERENCE SECTIONChapter 3 

94

In the lower part of the dialog box you can assign various commands to the context-
sensitive menu of the right mouse button. 
 

 

Fig. 70: Detail of the File Format Dialog Box 

The commands available in the context menu are listed under Current Commands. 
Any search path can be assigned its own context menu. 
 
Example: A search path only contains files to be sent by email. In this case two 
functions would be enough for the context menu. You could specify Open as the first 
command so that you can quickly check the file you want to send. The second command 
would be Send To... The other commands are not necessary in this case.  
 
The button with the arrow pointing left can be used to move commands to the Current 
Commands. Current Commands are the commands which will subsequently be 
available in the context menu. 
 
The button with the arrow pointing right can be used to move commands to the 
Available Commands. Available Commands are the commands which will not be 
subsequently available in the context menu. 
 
The Dividing Line button can be used to insert dividing lines between single commands 
to make it easier to read the contents of the context menu.  
 
If you modify the default context menu, i.e. remove some of the commands, you can 
restore it to its original state by clicking the Default button. 
 
If you select the Execute with Double Click command, the command in the context 
menu will not be executed unless you double-click on the right mouse button. 
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You can use the Up and Down buttons to move menu items or dividing lines to any place 
you wish. 

File Formats 

This command can be used to add new formats to the Job Manager or delete file 
formats. 
 
Note: Only the names of newly added formats, without previews, are displayed in the 
preview window. 
 

 

Fig. 71: Dialog Box for Adding or Deleting File Formats 

Existing formats are shown and new formats added in the left part of the dialog box. The 
suffix of the particular format is shown next to it on the right. 
 
Underneath you can specify the frame colour for the preview images and the selection 
color by clicking in the color area. 
 
Note: Only newly specified formats can be deleted again. 
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Define Font... 

If you activate this menu item, the following dialog box opens: 
 

 

Fig. 72: Dialog Box for Selecting Font Type and Font Display in the Preview Window 

In the upper part of the dialog box you can define the font type, style and size for the 
captions of the preview images in the Job Manager preview window.  
 
You can make other settings in the lower part of the dialog box.  
 
The image captions can be shown crossed out or underlined and you can specify the 
font color. 
All these commands are intended to make it easier to recognize and distinguish the 
preview images. 
 
Under Scripts you can choose how the caption is to be displayed, for example an 
English person would choose Western and a Arab person Arabic. 
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Define Language... 

If you execute this command, the dialog box for selecting the language opens: 
 

 

Fig. 73: Dialog Box for Selecting the Language 

Here you can choose the language in which the menus and dialog boxes of the Job 
Manager are to appear.  
 
Simply click on the arrow pointing downwards and choose the language you wish. 
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Create Backup... 

If you execute this command, the Backup dialog box opens: 
 

 

Fig. 74: Job Manager Backup Dialog Box 

Select from the input box entitled Backup Directory the directory or the data carrier 
where the data is to be saved.  
 
Type the the backup File Name in the box underneath. Backup files always have the 
suffix *.jmn. 
On the right you can specify if the drive name is to be saved as well. This command is 
turned off in the default version. 
 
Note: You should not execute this command unless two paths exist with the same 
search directories but different drive names, so that the backup routine is able to 
distinguish between them.  
 
If you execute the command Create Backup for CD, the data and the Job Manager 
itself will be copied to the CD. 
 
Note: You can cancel the backup by pressing the ESC key. 

Delete Preview Cache 

The preview images created by the Job Manager are stored in a cache for faster access. 
When should you delete the preview cache? 
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You should delete the preview cache when you delete a *.jmn file. The search paths and 
directories of the preview images no longer exist but the image information is still in the 
cache, although it is no longer needed. 
 
When the preview cache is deleted, the preview images of the single search paths have 
to be read in to the preview window again, which can take a while if there is a large 
number of images. 

The View Menu 

The appearance of the Job-Manager can be modified in the View menu. Here you can 
turn the symbol bar, the status bar, the path selection, the directory groups, the search 
masks and the search mask view on or off. 
 
If you eexecute the Job Manager in Front command, the Job Manager will always 
remain in the foreground. 
This command is especially useful in conjunction with EuroCUT or CoCut Professional. 
 
In the part-screen mode you can positione the Job Manager window in such a way that 
the entire working area of EuroCUT/CoCut Professional is available to the user and the 
Job Manager can also be seen. 
 
Advantage: Jobs to be edited can be found or opened quickly or dragged to 
EuroCUT/CoCut Professional. 

The ? Menu 

A click on the ? menu opens the Info about Job Manager dialog box. Your Job 
Manager version is shown here and the number of files stored and the necessary 
storage space. 
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The Commands in the Job Manager 

Key Function 
 
Right mouse button Context-sensitive menu 
 (mouse cursor is on of the preview images preview image) 
  
SHIFT+  
 
Left mouse button  Select jobs from – to 
 
CTRL+ 
 
N New file 
O Open file 
S Save file 
F Search hard disks  
Left mouse button  Select single images 

The Open…Command  

 CTRL-L 
The Open command is used to retrieve /open existing jobs, in the CoCut Professional 
format, either from your hard drive or a diskette. The file is loaded to your screen, i.e. to 
your working area, and can then be further modified or edited.  
In addition, you can delete jobs. You will first be asked if you really want to delete the 
job. 

The Save Command 

 CTRL-S  
This command is used to save the job you have been working on. If you have previously 
saved the job, the file name and directory under which it was saved will be retained. 
The previous version is overwritten and will no longer be retrievable.  
 
If you are saving a job that has not yet been saved, CoCut Professional will 
automatically activate the Save as... command when you click on Save. Here you will 
be able to enter a file name and an appropriate directory for this job. 

The Save As… Command 

 SHIFT-CTRL-S 
This command is used to save a new job under a file name and in a directory the user 
is free to choose.  
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You may also use the Save As... command to change the name of an existing file. This 
is particularly useful if you have used or intend to use an existing design to create a 
new one but would like to retain the older version without overwriting it. 
 
You can also use this command to save a job on a diskette. Simply specify the 
appropriate disk drive in the dialog box. 

The Import Command 

 CTRL-I 
With this command you can import artwork which is not saved in the CoCut Professional 
CCJ format. 

The Export Command 

 CTRL-E 
If you want to use a job in another graphics programm you must convert it to a different 
format for export. 

The Online Service… Command 

This command connects you directly to the support page of EUROSYSTEMS S.à.r.l. and 
the General Distributor RCS Systemsteuerungen GmbH. 
 
Note: If you have not installed a browser, a text file will be displayed, informing you what 
to do so that you can make use of the advantages of the online service. 
 
After registering with EUROSYSTEMS-ONLINE you have these additional facilities: 
 
• You can make use of our file service. 
• If you are registered, you have the possibility of importing the latest service releases 

or demo versions of our software products free of charge. 
• It is not necessary to state your address every time you order from our online shop. 
• Specialist traders and distributors have access to the Business Center. 
 When you would like to download data subject to a charge, you must have a credit on 

your account with RCS-ONLINE. 

The Print Command 

 CTRL-P 
With this command, you send the job you are working on to the 
default printer in any size you require (tiling). 
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The Cut/Plot Command 

 S 
This command activates the Cut/Plot/Route module.  

The Quit Command  

 CTRL-Q 
With this command you close CoCut Professional and return to the Windows 
environment. If you have not yet saved the CoCut Professional file you were 
working on, you will be prompted to do so now. 

3.2 The Editing Menu ! ONLY CoCut Professional ! 

The Undo Command 

 F5 
This command makes it possible for you to undo or reverse the last few editing 
proceduresyou have completed. The standard or default setting allows for the last five 
steps to be reversed. You can increase this number in the Setup menu under 
Settings/Diverse/Number of Reversible Steps. The default value is designed for a 
computer with 8 megabytes of RAM. Only if your computer is equipped with more RAM 
do we advise an increase in the number or reversible steps. The maximum permitted is 
100. 
 
Note: This setting can only be changed for a new file (File menu, New). 

The Redo Command  

 F6 
This command is the opposite of Undo.  
It restores the editing functions you have previously chosen to undo. 

The Cut Command  

 CTRL-X 
With this command you can remove objects from your working area and temporarily 
store them on your computer’s clipboard. This is a very convenient way to insert an object 
in a different position, in a different file or even in a different program. 

The Copy Command  

 CTRL-C 
With this command you can store items on the clipboard without having them removed 
from your working area. 
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The Paste Command  

 CTRL-V 
With this command you retrieve items from the clipboard and insert them into your job. 
When you activate this command, the cursor turns into a right angle containing the word 
Insert.  
 
Point the tip of the right angle at the exact location where you would like to insert the 
object and press the left mouse button to execute the Paste command. 
Note: Only bitmaps with a color depth of max. 8 bits per pixel can be read back via the 
Windows clipboard. 

The Paste Contents... Command  

This command lets you import images to CoCut Professional via the clipboard. 
 
Note: This menu item is not active when objects are copied in CoCut Professional. 

The Select All Command  

 CTRL-A 
With this command you can simultaneously select all objects in your current job, i.e. all 
objects inside as well as outside your working area. The selected objects can then be 
grouped, combined or moved. 

The Ready to Cut ... Command 

This command can be used to prepare an object with a specified line thickness or fill for 
cutting. 

3.3 The Design Menu ! ONLY CoCut Professional ! 

The Rotate Axis Command 

 A 
This command is used to rotate objects by 90°.  
You need this option regularly if you want to adjust your objects quickly to the running 
direction of the vinyl without performing the rotate command. 
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The Horizontal (X) Mirror Command  

 X 
This command mirrors a selected object on an imaginary horizontal axis through its 
center point. If you select more than one object, they will be mirrored around an 
imaginary horizontal axis located in the middle of the selection box indicated by the eight 
black squares. 
 
If you have not selected any objects, your entire design (all objects) will be mirrored 
horizontally. 

The Vertical Mirror Command 

 Y 
This commandd mirrors a selected object on an imaginary vertical axis through its center 
point. If you select more than one object, they will be mirrored around an imaginary 
vertical axis located in the middle of the selection box indicated by the eight black 
squares. If you have not selected any objects, your entire design (all objects) will be 
mirrored vertically. 

The Delete Command  

 DEL 
On your keyboard you will find a key labeled DEL or delete. The DELETE key is used to 
permanently remove selected objects from your design. The objects that you want to 
remove have to be selected first.  

The Duplicate Command  

 CTRL-D 
Click with your left mouse button on the Duplicate command or activate it via the 
CTRL+D shortcut. The previously selected object or objects will now be duplicated. The 
positioning of the duplicated objects occurs according to the values entered in the 
Setup dialog box accessible from the Settings/Diverse menu.  
 
Note: You can also duplicate objects in your design simply by using your mouse. 
Select the object(s) first. Drag the object(s) to the location where you would like to 
have it/them duplicated. Without releasing the mouse button, click once with the other 
mouse button and the selected object will be automatically duplicated. 

The Clone Command 

You must select the object to be cloned first. Then click on the Clone command with the 
left mouse button. 
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When you clone an object, you create a copy linked to the object. Any changes made to 
the original object will automatically be made to the clone as well. 
 
If the size or shape of the clone is changed it becomes an original object again. 

The Group Command  

 CTRL-G 
With this command you can group several objects so they can be selected and 
manipulated as a single object. This is particularly useful when you are trying to move 
several objects at once without changing their positions relative to each other.  
Be sure to select the objects first, then activate the Group command and move this 
newly formed group of objects to the desired location. It is now no longer possible to 
manipulate the objects within the group individually. 
If you need to do so, please see the Ungroup command described below.  

The Ungroup Command  

 CTRL-B 
This command is used to reverse the Group command, i.e. it separates objects that were 
previously grouped. The objects can now be selected and manipulated as individual 
objects. 

The Combine Command  

 CTRL-K  
Similar to the Group command, the Combine command also converts several 
individual objects into one single object. The main difference is that with the Combine 
command CoCut Professional ceases to look at these objects as a group of individual 
objects with their own set of attributes, such as color layers, etc.  
 
Consider the following example: 
 
You have created two squares with different color layers, one somewhat smaller than the 
other. Now you place the smaller square in the center of the larger one. Select both 
objects and execute the Combine command. The two squares are combined into a 
single object with only one color layer (the one assigned to the larger square). The larger 
square is recognized as the outer contour, while the smaller square inside forms the 
inner contour of the new object.  
 
The space between the two contours is filled with the color selected from the layer box. A 
hole the size of the smaller square remains in the center. 
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The Break Apart Command  

 SHIFT-L 
With this command you undo the Combine command described above, i.e. the 
objects that were previously combined can once again be selected and manipulated as 
individual objects.  

The Draw Command  

When you select this command, a flyout menu appears which combines all basic CoCut 
Professional tools for designing artwork. 

Register Marks  

With this option you can place register/crop marks in your design, which will later 
facilitate alignment application of the various layers in a color-separated job. When you 
select this command, the cursor turns into a square with a cross-hair on it. Place the 
cursor at the exact location where you wish to have register mark cut out and click on it 
with your left mouse button. A register mark is inserted automatically at this location. 
Repeat this procedure for additional register marks. All marks will be cut in each layer, 
regardless of layer color or order. 

The Perforation Mark/Drill Hole Function 

With this option you can place perforation marks or drill holes in your design.  
When you select this command, the cursor turns into a circle with a cross-hair over it. 
Place the cursor at the exact location where you wish to have a hole drilled and click on it 
with your left mouse button. A perforation mark is inserted automatically at that location. 
Repeat this procedure for additional perforations. The holes will be cut in each layer, 
regardless of layer color or order. 
 
Note: This option is designed specifically for CoCut Professional users who have flatbed 
plotters with routing capabilities. 

Clockwise Rotation of Objects  

 > 
This command is used to rotate selected objects set clockwise. 

Counter-Clockwise Rotation of Objects  

 < 
This command is used to rotate selected objects counter-clockwise. 

The Close Contour Command  

This command is used to close the contour of a selected object.  
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The status line at the bottom of your working area indicates whether or not your design 
contains an open contour. (If it does, the object with the open contour will actually be 
counted as two!) Activate the Close Contour command to close the object and make it 
one. 

The Open Contour Command 

This command is used to open a closed contour of a selected 
 object. 

The Round Corners Command 

With this command you can round off corners, both inside and outside, either for the 
selected nodes or entire selected objects. It is particularly useful for rounding lettering. 

3.4 The View Menu ! ONLY CoCut Professional ! 

The Zoom In Command  

 + 
This command, used to magnify all or parts of your design, can also be activated by 
clicking on the Zoom icon in the tool box and then selecting the icon with the magnifying 
glass and the plus sign in the flyout box. Once you have activated this command, the 
cursor turns into the shape of a magnifying glass containing a plus sign.  
 
Using your left mouse button, you can select the area in your design you wish to magnify 
by dragging a box around it. Once you release the mouse button, CoCut Professional 
zooms in on the selected area and redraws it.  
 
Note: The zoom-in procedure can be repeated several times for further magnification 
until CoCut Professional issues an audible alert that indicates the maximum 
magnification level has been reached. 

The Zoom Out Command  

 - 
This function reduces the size of the screen step by step. 

The Full Page Command  

 B 
This command is used to display the working area in its entirety. This command can also 
be accessed via the toolbox (click on the icon depicting a sheet of paper in the Zoom 
flyout box). 
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The Show All Command  

 F4 
This command modifies the representation of the vector drawing in such a way that all 
the objects can be seen on the screen in their maximum possible size. 
 
Note: Holding the SHIFT key down while executing this command will provide a full-
screen display of a previously selected object or objects. 

The Show Selected Objects Command  

 SHIFT-F4 
With this command you can have CoCut Professional display only selected objects in 
your working area in their maximum possible size. 

The To Front Command 

 CTRL-O 
When you are working with several color layers, you can use this and the following 
commands to change their sequence. 
With the To Front command the selected object/color layer is moved to the very front or 
top. 

The To Back Command 

 CTRL-U 
With this command the selected object/color layer is moved to the very back or bottom. 

The Forward One Command  

 PgUp 
With this command the selected object/color layer is moved to the next higher color 
layer. 

The Back One Command  

 PgDn 
With this command the selected object/color layer is moved to the next lower color layer. 

The Reverse Order Command  

 U 
With this command the sequence of objects/color layers is reversed. Whatever was on 
top is moved to the bottom, and vice versa. All objects or color layers in between are 
reversed as well. 
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The Always in Front Command 

 CTRL-Y 
With this command the CoCut Professional window remains permanently in the front.  

The Refresh Screen Command 

 CTRL-W 
This command tells CoCut Professional to redraw all objects currently displayed in your 
working area. Use this command when objects which cannot be selected with the mouse 
cursor are visible on the screen. 

3.5 The Tools Menu ! ONLY CoCut Professional ! 

The Contour Line... Tool  

 K 
This command provides a number of selected objects with an outline. 
Unlike the Outline command, this tool can also be used to provide bitmaps with outlines. 
Instead of individual objects being outlined, if possible an outline is created to 
encompass all the selected objects. Therefore the function is particularly useful for 
creating cutting lines for stickers. The objects for the sticker can be put together as you 
wish. The outline is then created at whatever distance you wish from the objects. It can 
later be used for cutting out the printed sticker. 
 
First select the objects you wish to frame. Then click on Contour Line... in the Tools 
menu. 
The following dialog box appears where you can make the settings: 
 



 

 

REFERENCE SECTIONChapter 3 

110

 

Fig. 75: The Contour Line Dialog Box 

The fields in the Create Contour part of the dialog box allow you to influence the 
calculation of the contour line. In principle, any objects which are not white are included 
in the contour calculation. 
 
Therefore the background of the artwork to be outlined should ideally be white. Bitmaps, 
in particular, often contain light-gray patches which may arise during scanning. 
With the aid of the field Maximal Gray Value you can determine that gray patches 
above the specified intensity should not be framed. 
 
You can enter values between 50% and 99% or set them with the filter. 50% represents a 
relatively dark gray and 99% is almost white. 
You can choose between three options in the Accuracy box. 
Low accuracy works the most quickly. If you are not satisfied with the result with the low 
setting, choose the middle or high setting. In the latter cases it will take longer to 
calculate the contour line. 
 
Note: If you only select one bitmap, the Accuracy box cannot be activated. 
 
If you check the Retain Interior Parts box, any interior parts which may be created will 
not be deleted. This gives you the possibility to cut out parts of the graph by covering it 
with light-colored “plasters”. 
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This is illustrated below: 
 

 

Fig. 76: Retain Interior Parts 

On the left you can see the two objects in their original state. A small white circle is 
superimposed on the black circle. On the right the circle is displayed with the outline 
which has been created.  
 
As the Retain Interior Parts field was activated, the inner circle was also retained when 
the outline was created. If this field had not been activated, only the exterior outline would 
have been created. 
 
Note: The default is that the Retain Interior Parts command is not active. 
 
The lower part of the Contour Line dialog box, Offset and Line Drawing allows you to 
determine the appearance of the contour lines. 
With Offset you can specify the distance of the contour line from the image. If you enter 
the value “0”, a contour line will be created directly adjoining the edge of the selected 
objects. If you enter a value smaller than 0 the contour line intrudes on the objects to be 
outlined. 
In the Corner Shape field you can determine the appearance of the corners of the 
contour line. 
If you choose the Normal option, the mathematically exact point will be calculated on the 
contour. This means that the contour line can be considerably lengthened at pointed 
corners, which often leads to unsightly results. 
In such cases you can achieve more satisfactory results by choosing the Cut Off and 
Round options. 
 
The Cut Off option shortens the contour by the specified amount and cuts off the corner 
with a straight line. 
The Round option changes the corner into a rounded curve. If you activate the 
Enhanced... button, an additional dialog will appear in which you can make the exact 
settings for the design of the corner. 
 
Note: The default settings in the Enhanced Settings dialog box should only be altered 
in exceptional cases! 
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Fig. 77: Enhanced Settings 

To optimize the contours, four different types of filter are available: 
 
Filter 1: 
Filter Contours reduces major noise (garbage) in bitmaps by ignoring contours 
consisting of less than five pixels.  
 
Filter 2: 
Reduce Tangential Points  reduces the number of points or nodes on a curve. The 
higher the degree of reduction, i.e. the fewer the nodes that are retained, the further the 
scanned curves will deviate from the original. 
 
Filter 3: 
Adjust Curves considers the overall direction of straight lines and curves and eliminates 
stray horizontal and vertical lines that appear to have no effect on them.  
 
Filter 4: 
Smooth Curves aligns the tangents of curve points. The higher the degree of 
adjustment, the more the curves are smoothed. Smooth curves with perfectly aligned 
tangents have the advantage of producing very clean cuts.  
However, excessive smoothing can once again cause too much deviation from the 
original. Therefore, a moderate value is preferable. 
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If the Include Small Objects option is activated, closed objects will also be created 
from small objects. The first filter cannot be used when this option is activated. 
 
The Without Intersection option allows you to eliminate automatically any intersections 
which may appear within the outlined objects. 
Once you have made the desired settings in the Enhanced Settings dialog box, confirm 
by clicking on OK to return to the main dialog box. 
 
To create the contour line, select Calculate. Depending on the complexity and number 
of the objects selected, it may take several minutes for the outlines to appear. 

Fotocut 

This module creates vectors from bitmaps. 
 
Mode of operation: 
Fotocut creates raster line patterns from Windows bitmap files (*.BMP, *.PCX, & *.TIF). 
These patterns can be cut on a cutting plotter or similar device.  
The image is divided into logical pixels and the average grayscale is worked out for 
each of these logical pixels. Thus, an image is created having fewer pixels than the 
original. This image is then used to create horizontal or vertical lines, circles, squares, 
etc, whose width is proportional to the grayscale in the corresponding place. 
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The FotoCUT Dialog Box  

Open the Fotocut dialog box by clicking on the menu item of this name. 
 

 

Fig. 78: The Fotocut Dialog Box 

The various elements of the Fotocut dialog box are described in detail on the following 
pages. 
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General Settings 

Pixels in X Direction 

In this box enter the number of pixels which are to be combined in X direction into a 
logical pixel. 
 
Note: The smaller the value entered in this box, the better the output quality of the bitmap 
will be. 

Pixels in Y Direction 

In this box enter the number of pixels which are to be combined in Y direction into a 
logical pixel. 
 
Note: The smaller the value entered in this box, the better the output quality of the bitmap 
will be. 

Rest Width 

The remaining width of a line (only for lines) in mm of the line/column size. 
The remaining width is also as least as wide as the total amount of vinyl stripes and weed 
garbage. 
As the stripe width depends on the number of pixels (per stripe) and determines the 
possible remaining width, the original bitmap must be available in a “cuttable“ size. 
 
Example: If the bitmap is so small that 10 pixels only give 1mm, the remaining width 
cannot be 1 mm! 
 
Note: If the user enters too large a value for the Rest Width, the old value is taken and a 
message appears.  
 
Contrast 
 
The line/column size is determined by dividing the bitmap into logical pixels. The width of 
the stripe depends on the minimal grayscale setting and the contrast. The maximal width 
is the line/column size minus the rest width value. The width of the stripe will then be 
calculated from the average grayscale value according to the contrast value. The contrast 
is the relation between black and white in %, i.e. with 100% contrast 100% black will be 
displayed on the maximal and 100% white on the minimal stripe width. If the contrast is 
reduced, 100% black will be calculated with, for example, only 50% of the maximal stripe 
width.  
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Minimal Grayscale  

The minimal grayscale is a limit for the grayscale. Thus, a background which has the 
same grayscale as a bitmap can be deleted.  
 
Note: This value only needs to be considered when an image is darker than its 
background.  
 
The following image will serve as a model for all the examples: 
 

 

Fig. 79: Model for Examples (photo.bmp) 

Negative 

This command reverses the grayscale values, i.e. 100% black, for example, becomes 0% 
white and vice versa.  
 
 positive negative 
 

 
Fig. 80: Example of Reversing the Grayscale Values 
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Reverse Direction (only for lines) 

If this command is executed, the width of the lines will be directed downwards. 
 
 Line width upwards Line width downwards 
 

 
 
Detail: 
 
 Line width upwards Line width downwards 

 

Fig. 81: Example of Reversing the Line Width 

Double (only for lines) 
 
This command creates a line of double width, i.e. upwards and downwards. 
 
 Line width upwards Line width upwards and downwards 
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Detail: 
 
 Line width downwards Line width upwards & downwards  
 

 

Fig. 82: Example of Line Width Enlarged Upwards and Downwards 

Horizontal or Vertical 

Use these buttons to specify the running direction of the lines. 

Bitmap 

The data of the original image are shown in the field entitled Bitmap. The Width and 
the Height of the image in pixels and the resolution in dpi are shown in the upper part 
and the Width and Height of the image appear below in millimeters. 
 
Relations between the entries in the General Settings field: 
 
Example 1: 
 
The following entries have been made: 
 
Pixels in X direction  = 1 
Pixels in Y direction  = 10 
Rest width = 2 
Minimal gray scale = 0 
Direction  = horizontal 
Negative = not active 
Reverse direction = not active 
Double = not active 
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Result: 
 

 
 
xample 2: 
 
Pixels in X direction  = 3 
Pixels in Y direction  = 15 
Rest width = 5 
Minimal gray scale = 0 
Direction  = horizontal 
Negative = not active 
Reverse direction = not active 
Double = not active 
 
Result: 
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In the illustration above you can see that even small modifications of the values produce 
very different results. 

Weed Aid 

Create Weed Aid 

The lines are thickened at the ends so that the image can be weeded more quickly. 

Stripes per Strap 

In this box you can enter the number of stripes that each strap should contain. 

Strap Width 

You can specify the width of a strap in this box. 

Strap Thickness 

You can specify the thickness of a strap in this box. The probable Number of Objects 
appears underneath this box. 
 
Example of Stripes per Strap, Strap Width, Strap Thickness and Stripes: 
 

 

Modes: 

In the FotoCUT dialog box you can choose between the following modes: 
 
Lines, Rhombuses, Circles, Squares, Single Rhombuses, Single Rectangles 
and Spirals.  
 
Which mode will obtain the best result depends on the bitmap used and the settings 
made. 



 

 

REFERENCE SECTIONChapter 3 

121

Note: It is not often possible to judge the quality of the result from the screen display. 
You should print out the result so that you can assess it accurately and don‘t run the 
risk of wasting expensive vinyl 

The Attributes…Command 

This command lets you increase the number of pixels in an image. Increasing the number 
of pixels results in the image increasing in size accordingly. 
The resolution is indicated in DPI (dots per inch). 
This menu item also provides additional information about the bitmap. The Storage 
Space required by the bitmap in the working storage and the Color Depth used are 
shown. 

The Set Aligning Marks Command 

 SHIFT-J 
Tools/Set Justification Marks automatically sets four justification marks on the 
selected object. The size and position of the selected object as well as the type of 
plotter (OPOS, OPAL) can be edited using Basic Settings in the Settings menu.  
The marks are not located in a color layer, are always shown in black, remain the same 
size when the image is resized and are positioned in a group. 
 
OPOS systems normally require square marks with sides of 3mm. Unlike the OPAL 
marks, they are not cut during plotting. 
 
Mimaki marks consist of a right angle open towards the object with sides measuring 10 
to 15mm. They mustn’t be cut as the Mimaki plotter takes the first mark at the top right 
end of the angle as its point of origin after justification.  
 
For this reason a mini object is created at this point, or a square when the weed border is 
turned on, and the marks are deleted. 
 
For testing purposes the Mimaki marks can be displayed and also cut by recalling the 
cutting preview with the CTRL key held down. But in this case the objects are not cut in 
the correct position. 
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Fig. 83: Dialog Box for Setting the Justification Marks 

Example of the Justification Marks Command with Universal Marks 
The Justification command is needed for producing adhesive labels and stickers. The 
printed foil with justification marks is inserted in the cutting plotter and the copies are 
cut with outlines. This command can be used for plotters with automatic optic systems, 
such as Summa OPOS or Mimaki OPAAL. 
 
The Universal Justification command can be used for many plotters which do not have 
an optic system. 
 
Load your bitmap and give it an outline with the Outline tool. 
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Set justification marks 
 

 
 
Align objects with universal justification marks 
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Set justification marks 
 

 
Print material with justification marks 
 

 
 
Transmit to the cutting module 
 

 
 
Make settings for the special plotter 
 

 
 
Read back values from the plotter and align objects with universal justification marks 
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The Measuring Tool  

The measuring tool is used to perform measurements (between any two points) in your 
design.  
 
As soon as you click on the Measure icon in your tool box, the cursor changes into a 
bull’s eye. Move the center of the bull’s eye to the first point, i.e. the point from which you 
intend to measure.  
 
While holding down the left mouse button, drag the bull’s eye to the second point, i.e. the 
end-point of the distance you are measuring. A guideline provides a visual connection 
between the two points. 
 
If you hold down the SHIFT key during this procedure, the measuring can be limited in a 
horizontal or vertical direction. This makes it easier to measure straight lines accurately. 
 
Note: All objects are resized proportionally. When bitmaps are rotated, the bitmaps are 
also enlarged but not the objects shown in the bitmaps. 
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The Welding Tool  

This tool is used to combine two or more selected objects into a single one by joining 
overlapping areas and deleting extra lines. 
 
If there are objects containing line attributes or fills on the CoCut Professional working 
area, click on the Cut button and the following dialog box will open: 
 

 

Fig. 84: Dialog Box for Converting Lines and Fountain Fills 

This dialog box permits you too convert lines and fountain fills to curves.  

If there are objects with pencil attributes and the Convert Lines command is not active, 
the pencil attributes will not be cut. 

If there are objects with fountain fills and the Convert Lines command is not active, the 
pencil attributes will not be cut. 

 
Regardless of the number and shape of the selected objects you can choose from the 
following options: 
 
Automatic, By Color, Full Surface or Screenprint. 
 
The other boxes depend on the option selected and will therefore be described in the 
relevant section. 
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Fig. 85: The Welding Dialog Box 

One of the main applications for automatic welding is to weld serifs used in script fonts, 
since serifs of one letter tend to overlap with those the next, which is, of course, 
something you want to avoid. 
 
Automatic welding eliminates those overlaps and creates smooth transitions from one 
serif to the next, which can then be cut cleanly and applied as a continuous piece. Should 
you find certain parts of the letters missing after performing an automatic weld, select the 
Undo command and reduce the character spacing from 100% to 99%. This results in 
nodes located exactly on top of one another being moved so that they can be recognized 
as separate nodes and the welding can be carried out properly. 
 
The By Color option removes all areas covered by overlying colors. It does not matter 
how many objects and colors you select.  
 
If some of the selected objects have open contours, you can close them or add a line of a 
specified width. This is described in the Automatic section.  
 
It may happen that the same color appears in different color layers. If you perform the 
command Merge Same Colors, such layers will be combined into a single layer. 
 
You can generate an Overlap or an Offset at the point where two colors meet. 
Select Overlap or Offset in the Seams field and enter the desired amount. 
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Full Surface underfills objects of one color which are covering areas of another color. 
The partially concealed objects are redesigned so that they underlie the entire surfaces 
of the overlying objects. 
For open objects you can use the same procedure as described under Automatic. 
 
This application is most useful for shop window lettering which is often difficult to mount 
when the By Color option is used. If you have a maximum of two or three colors it is best 
to work with the Full Surface option, where the single vinyl colors are stuck on top of 
each other.  
 
Screenprint is an especially powerful tool for screen printers. 
First of all, the intersections of the single color layers are eliminated. Then the colors are 
layered in the sequence specified in the Color Sequence box. Finally a small line is 
added as an overlap at the “seams” of the single color layers. 
 
You can determine the desired color layering in the preview window on the right side of 
the dialog. Clicking on the mouse lets you “grasp” a layer and drag it to its proper 
position. The chart indicates the position of the layers.  
 
In the Seams and Overlap boxes you can enter the desired overlap between the color 
layers. In each case the lower layer underlies the higher one. 
 
You also have the possibility of merging recurring colors in one layer. To do this, select 
Merge Same Colors. 
 
This option is especially useful for creating templates for screen printing, as in this 
printing process the darkest color is always applied last so as to avoid streaks which 
might occur when applying the individual colors.  
 
Note: If your artwork includes objects with open contours, proceed as described in the 
section on the Automatic mode. 
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3.6 The Settings Menu ! ONLY CoCut Professional ! 

The Settings menu is used to select basic setups for default values for working with 
CoCut Professional. There is a dialog box available to the user for each basic setting 
(e.g. Diverse, Mouse, Plotter). 

The Basic Settings ... Option 

Diverse... 

You have a choice of the following default settings: 
 

 

Fig. 86: The Dialog Box for Various Basic Settings 

Duplicated Values 
 
X Offset 
You can enter the distance you wish to have between the horizontal duplicates in this box.  
 
Y Offset 
You can enter the distance you wish to have between the vertical duplicates in this box. 
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Move Objects 
 
Increments in X Direction 
With this entry you can determine the incremental distance a selected object moves 
vertically when you press the arrow keys on your keyboard. 
 
Increments in Y Direction 
With this entry you can determine the incremental distance a selected object moves 
vertically when you press the arrow keys on your keyboard. If you later decide that you 
want to move objects in smaller increments than you have indicated here, you have the 
possibility of reducing the increments as follows: 
 
Note: Pressing the SHIFT key while using the arrow keys reduces the increments to one 
tenth of the original value. Pressing SHIFT + CTRL while using the arrow keys reduces 
the increments to one hundredth of the original value. 
 
Undo Command 
 
Number of Reversible Steps 
This entry concerns the Undo command discussed earlier in the Edit Menu. 
 
No Undo/Redo for Bitmaps Exceeding ... 
For bitmaps exceeding the value entered in this field the Undo/Redo functions are 
automatically turned off, i.e. any changes made to these bitmaps using the Image menu 
cannot be reversed. 
 
The reason for this is that the time required for bitmaps above a certain size is too long, 
as a copy of the original has to be made for every undo or redo step. 
The value entered in this field should be between 5% and 10% of the RAM capacity. 
The advantage of this function is that you save time. 
 
Delete Undos Before Printing  
This command deletes all undos made to date. 

Mouse 

This is where you can assign a specific command to your right mouse button, which will 
then be activated with a single click. Display the list of available functions by clicking on 
the arrow next to the list box. Double-click on the command you wish to assign. 
 
Plotter  
In this setup category you can select a number of important parameters for outputting to 
your plotter/cutter.  
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You can activate or deactivate this option via the Cut Preview window.  
In the CoCut Professional dialog box the preview window can only be activated and 
deactivated if it has previously been activated in the plotter setup. The background of the 
window appears in gray if it is not activated.  
 
Wait after Segment 
Choose this command if you want the plotter to wait after cutting each segment. A 
segment refers to the partial output of a sign which, in terms of size, exceeds the cutting 
area of the plotter and therefore has to be cut in sections. This option is commonly used 
with flatbed plotters that are not equipped with an automatic roll-feed device, in which 
case the size of the segment is equal to the maximum cutting area of the plotter. 
 
Segment  
This indicates the maximal area which can be plotted in in one piece. 
Once the segment has been cut, the cut material must be removed and new material 
loaded and repositioned manually. 
 
Sort 
This option refers to the sequence in which objects in your design are cut. If you choose 
to sort prior to cutting, all inner sections of your design or objects will be cut before the 
outer sections, and all objects will be cut in order of position on the X axis. With roll or 
drum plotters, this keeps back-and-forth movement of the material to a minimum and thus 
maximizes output quality, particularly with friction-fed plotters. This option is also 
important for routing.  
Selecting this option slightly reduces output speed. 
 
Weed Border 
This command is used to cut a border or frame around your design to facilitate weeding. 
You can specify the distance between the weed border and the outermost points of your 
design. 
 
Overlap 
When cutting a sign in sections, you can choose an overlap for each segment to 
compensate for possible material shrinkage. Cutting signs in sections becomes 
necessary when the size of the design exceeds the capabilities of the plotter, i.e. the 
maximum cutting area. 
 
Segment Offset 
This command lets you define the distance between the segments, i.e. the distance 
between the end of one segment and the beginning of the next. 
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Copy Offset 
This command lets you define the distance between multiple copies of your design, i.e. 
the distance between the end of one copy and the beginning of the next. 

Set Register or Aligning Marks 

You can use this command to edit the size, position and type of marks (OPOS, OPAAL). 

Working Area  

This is where you can redefine the size of your working area. Besides various standard 
settings, you can specify up to 10 user-defined sizes. 
This is a useful tool for users of routing and engraving machines, as they no longer need 
to redefine the working area each time. 
The color of the working area can be defined by the user, thus guaranteeing better layout 
control on the screen. 
 
Note: Double-clicking on the shading of the working area (to the right or along the 
bottom) also opens this dialog box. 

The Rulers... Tool 

In this dialog box you can define the location of the rulers. If you find you are running out 
of space in your working area, you may choose not to have the rulers displayed at all. 
With a metric ruler every fourth increment is shown as a longer line and with a ruler in 
inches every second and fourth increment. 

The Measurement Unit Command 

This command is used to change the unit of measurement (mm, cm or inch). This can 
also be done by clicking the button located at the point where the horizontal and vertical 
scroll bars meet.  

The Edit Wireframe Mode 

 F9 
In this mode, only the contours or outlines of the objects in your design are displayed. 
The outline takes on whatever layer color you have chosen for that object. 
 
Note: If the layer color is white, the outlines are displayed as dotted gray lines.  
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The Undo/Redo Command 

 SHIFT-F7 
This command activates and deactivates the Undo/Redo command.  
 
One advantage of deactivating this command is that node editing is faster in the case of 
large or numerous objects.   
When there are several editing steps, the trial phase (original state → editing → 
temporary final state) can be reversed as follows: 
 
1. Deactivate Undo/Redo 
2. Edit objects 
3. Activate Undo/Redo 
 
You can restore the state prior to step 1 by clicking the Undo command in the Edit 
menu. 

The Select Language...Command 

If you activate this command, a dialog box for selecting the language opens. 

3.7 The Window Menu ! ONLY CoCut Professional ! 

The Default Command 

 CTRL+1 
This command activates the CoCut Professional default toolbar. 

The Color Layerbox Command 

 CTRL+2 
This command activates or disables the CoCut Professional Color Layerbox. 

The Tools Command 

 CTRL+4 
This command activates or deactivates the CoCut Professional Toolbar. 

The Object Info Status Bar Command 

 CTRL+8 
This command activates or deactivates the CoCut Professional Object Info Status 
Bar. 
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The Element Info Status Bar Command 

 CTRL+9 
This command activates or deactivates the CoCut Professional Element Info Status 
Bar. 

The Design Command 

 O 
This command activates or disables the CoCut Professional Object Attributes Toolbar. 



 

 

REFERENCE SECTIONChapter 3 

135

3.8 The Help Menu 

About...  

Clicking on About... will activate an information panel containing pertinent information 
on CoCut Professional, such as the serial number, version number, free disk space, the 
processor and coprocessor. 
 

 

Fig. 87: The About... CoCut Professional Dialog Box 

The product packing will be shown in the upper left part of the dialog box. General 
information about the product will be shown to the right. 
 
Your Operating System, Program Version with Serial Number and your 
Dongle/Copy Protection Licence Number will be shown underneath. 
 
All CoCut Professional Program Files with their Version Number, Size and Date will 
be shown in the lower part of the dialog box.  
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To speed up the search for certain program files you can specify in the box after Files 
which files are to be shown. 
 
If you click on the Info File button, a file will be created which contains all files and the 
infos in the *.ini files. This can be either displayed or transmitted. 
 
If you click on the Print button, an overview of the files which were previously in the 
selection box after Files will be printed. 
 
Note: It will help our support staff to rapidly eliminate any problems you may encounter 
with your CoCut Professional version if you let them have this list. 

Help... 

 F1 
This command launches the CoCut Professional online help. 

Object Info…  

 F10 
This window contains information on the objects in your working area, such as total 
number of objects, number of objects selected, text blocks, data blocks and bitmaps. 

Online Support  

You can get into direct contact with the support service of RCS Systemsteuerungen 
GmbH by clicking this option. If you have not installed a browser, you will be shown a text 
file informing you what to do if you wish to take advantage of the RCS-ONLINE service. 
 
In RCS-ONLINE you will find useful tips and tricks about EUROSYSTEMS products and 
also questions frequently asked about software and various cutting plotters. To enable us 
to eliminate problems as rapidly and efficiently as possible, we would ask you to 
immediately fill out the fields in the form under Software Registration if you are not 
registered with us. 

Live Update 

If you have access to the internet, you have the possibility of updating your software via 
Live Update. 
 
When you are connected to the internet select Live Update in the CoCut Professional 
Help menu. 
 
If there is a later version on our server, you will be shown the files and their sizes. You can 
start downloading them by clicking on the OK button. 
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4. CoCut Professional Tips & Tricks 
It is often only small things that make it difficult to work with new software. As with any 
new equipment, users often have questions and encounter problems that are easily 
solved. To save you a trip to the telephone, we have compiled a number of frequently 
asked questions and problems to which there are very simple solutions. 
 
CoCut Professional (all versions) 
 
1. CoCut Professional displays the message “Dongle not found“  
 
First of all you should remove all the devices connected to your computer behind the 
dongle (including the cable) and recheck whether the dongle can be detected. If the 
dongle can now be detected, you should insert a parallel port card into your computer 
and plug the dongle into this port. 
If the dongle still cannot be detected when it is plugged into the parallel port on its own, 
you must make sure that the parallel port is set to “Standard“, “Compatible“ or “SPP“. 
You can usually set up parallel ports which are integrated into the mother board of your 
computer via the BIOS settings. But if you have an interface, you will have to change the 
mode using the jumper. 
If the dongle still cannot be detected after this, check if the dongle can be recognized on 
another computer or another parallel port. Our experience in the last few years has 
shown that the dongle is very rarely faulty but that usually the parallel port where the 
dongle is plugged in is not working properly. 
 
Note: Never plug the dongle into a serial or SCSI port as this can damage it irreparably. 
USB dongles are defective when the red diode flashes. If the diode doesn’t light up, the 
dongle driver wasn’t properly installed. To install the dongle properly, execute file 
hdd32.exe, which you can find on your CoCut Professional CD in the HASP directory. 
 
2. The plotter cuts the first characters cleanly and then begins to draw 

indefinable curves.  
 
This is a typical buffer overflow problem when the plotter is driven serially. This occurs 
when the flow control is not properly set up for serial transmission. For serial data 
transmission most plotters are driven with the following parameters: 
 
Bits per second: 9600 
Data bits: 8 
Stop bits: 1 
Parity: None 
Flow control: Hardware 
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You can change these values under Windows 98 via Start / Settings / Control Panel / 
System / Plotter Manager / Ports (COM and LPT) / COM port (COMx) / Port Settings. If 
your plotter has other settings, you can generally find the values in the display under the 
Interface or Communication menu and enter them in the Windows control panel. 
 
3. I own a Roland PNC 950, 960 or CM12/24 cutting plotter. If the object 

height exceeds 70cm (about 24 ins) CoCut Professional proposes a 
segmentation, although the cutting objects don't exceed the foil width. 

 
These types of ROLAND plotter take the lower left corner as the default origin point. As 
most other plotters have specified the origin point in the lower right corner, CoCut 
Professional drives the plotters in such a way that the height of the object is cut 
widthwise from the vinyl. It is, however, possible to set up ROLAND plotters so that they 
take the bottom right corner as the origin point. To do this, first press the ROTATE key in 
the plotter’s operating field and then the SETUP key. With the CM series set the dip 
switch to ON. 
 
4. Although the 'read back' button is activated in CoCut Professional, this 

function always shows '0' in conjunction with a Mimaki plotter of the CG 
series. How can the plotter be set up so that the correct foil width is 
given? 

 
Mimaki CG series plotters will not react to the Read Back command unless they are run 
in the Host mode. For this proceed as follows: switch on the plotter, press the <-key in 
the operating field and once the plotter has measured out the roll of vinyl, keep pressing 
this key until “Priority“ appears in the display window. Press ENTER and then the ∧- key. 
The word Host will then appear in the display window. Confirm this selection by pressing 
ENTER. 
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5. What value must I enter in the Print field so a knife pressure of, for 
example, 100g is used in cutting? 

 
The following table shows the pressure values: 
 
Pressure Grams Pressure Grams Pressure Grams Pressure Grams 

1 20 11  70g 21 140 31 240 

2 25 12 75 22 150 32 250 

3 30 13 80 23 160 33 260 

4 35 14 85 24 170 34 270 

5 40 15 90 25 180 35 280 

6 45 16 95 26 190 36 290 

7 50 17 100 27 200 37 300 

8 55 18 110 28 210 - - 

9 60 19 120 29 220 - - 

10 65 20 130 30 230 - - 

Fig. 88: Pressure Settings 

To work with 100 g pressure, for example, you must enter 17 in the Print field. 
 
6. The output size on my Mimaki CG series is more than twice the size of the 

design. 
 
Mimaki CG51, 61, 101 and 121 plotters come with a resolution of 0.025 mm(.00098 in), 
although they are able to work with a resolution of 0.01mm (.00039 in) and also do so 
internally.  
 
The CoCut Professional drivers are set to 0.01mm (.00039 in) because the plotters can 
thus be driven faster and more accurately. 
To change your plotter’s resolution to 0.01mm (.00039 in), switch on the plotter, press 
the <- key in the operating field and once the plotter has measured out the roll of vinyl, 
keep pressing the function key until Interface appears in the display window. 
 
Keep pressing ENTER until you get to the menu item Step Size and then press the ∧- 
key. The display window then shows 0.01. Confirm this choice by pressing ENTER and 
END. 
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CoCut Professional for CorelDRAW 8 
 
7. Although all objects have been selected, only some of them are  
 transmitted to CoCut Professional.  
 
In your artwork there is probably an object that cannot be converted into curves, e.g. a 
bitmap. The quickest way to ascertain this is to switch to the wireframe mode. If you find 
this to be the case, select the object and lock it. After that you will be table to transmit all 
other objects to CoCut Professional. 
 
CoCut Professional for CorelDRAW 7 
 
8. After installing CoCut Professional for CorelDRAW 7 I cannot enlarge the 

symbol bar under Windows NT 4.  
 
This problem only occurs when using CorelDRAW 7 und Windows NT 4 and has now 
been eliminated in the lastest release, according to the CorelDRAW technical hotline. 
However, there are two ways of avoiding this problem: 
If Windows 98 is also installed on your computer as well Windows NT 4, you should 
reinstall CorelDRAW 7 under Windows 98, making sure that installation is performed 
into the same directory into which you have already installed CorelDRAW 7 under 
Windows NT 4. Then start CorelDRAW 7 under Windows NT 4 and adjust the symbol 
bar, quit CorelDRAW and restart your computer under Windows NT 4.  
If you have installed CorelDRAW 7 on another computer on which Windows 98 is 
installed and the CoRUN symbol has been added to the symbol bar, you can copy the 
files CDRBARS.CFG, CDRMENU.CFG and CDRROLS.CFG onto a disk and from the 
disk copy them onto the Windows NT 4 computer into the DRAW directory of 
CorelDRAW. 
 
CoCut Professional for CorelDRAW 6 
 
9. It is not possible to cut clones in Corel 6 with CoCut Professional.  
 
You must duplicate the objects to be cut or work from the Windows clipboard (copy and 
insert).  
When you try to cut a text inCorelDRAW 6 with CoCut Professional, a message appears: 
Too many nodes.  
CorelDRAW 6 is only able to create a limited number of nodes (about 3000) when 
converting text to curves. The more serifs and hence nodes the script has, the smaller the 
number of letters that can be converted into curves. 
You can only avoid the problem by setting several small text blocks with fewer letters, as it 
is not the total numbers of letters set but a too large number of letters in one text block 
that leads to this problem. 
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10. Although I activated the "Visual Basic for Applications" command when I 
installed CorelDRAW 10 I can’t add the CoCut Professional macro to the 
toolbar. 

 
You probably can’t start the Visual Basic Editor (CorelDRAW 10 under Extras /Visual 
Basic) either. There seems to be a bug during the installation of CorelDRAW 10 which 
you can eliminate as follows: 
Place the CorelDRAW 10 CD in your CD drive and start the Visual Basic Installation 
with the Windows Explorer by double-clicking on the file vba6de.msi (or vba6.msi) in the 
directory \Corel\Graphics10\Config\Redist\VBA6. After you have done this, Visual 
Basic ought to run under CorelDRAW 10 and therefore also the macro for CoCut 
Professional can be added to the toolbar, as described in the manual. 

 
11. How can I create a plot file to be sent later to the plotter on another 

computer via the COM port?  
 
Select “Plot To File“ in the CoCut Professional Cut dialog box. You will be asked to give 
the file a name. Enter, for example: F:\Path\File.plt. F:\Path is a network directory or a 
directory which has been made available on your hard disk. 
Open the MS-DOS input request (Start/Programs/MS DOS input request) on the 
computer where the plotter is connected to the serial port (e.g. COM 1) and type the 
following line: 
mode com1:9600, n, 8, 1, p, which means that COM 1 will be used for plotting with 
baud rate: 9600, parity: none, data bits: 8, stop bits: 1 and flow control: hardware. After 
that, type copy G:\Directory\File.plt com1. G:\Directory is the directory on the 
computer where File.plt is located. The plotter should now start cutting the plot file. 
  
Note: If the computers are not linked in a network, a diskette can also be used in a 
similar way to transport the data (in the above example replace F:\Path\ or. G:\Directory\ 
by A:\. Note that the amount of data is limited to 1.44MB so that only small plot files can 
be transported. 
 
Tip: Experienced users who would like to send plots to another computer regularly 
should create a batch file as follows: 
 
mode com1:9600,n,8,1,p copy %1 com1:  
 
Now create a plot file and double-click on this file in the Windows Explorer. As Windows 
normally cannot assign files with the suffix “PLT“ (in other cases you must choose 
another file suffix instead of PLT) you will be asked to choose a program for opening the 
file in an Open With dialog box.  
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You can select the previously created batch file using the “Other“ button and create a 
permanent link with the command “ Always use this file with this program“. 

 
12. How must I set up the Roland PNC 1000 so that it can be run with CoCut 

Professional? 
 
You must make the following settings in the plotter Setup (Raise the princh roll): 
 
Configuration COMMAND mode2  
INPUT PARALLEL 
SERIAL with parallel drive (e.g. LPT1) 
With serial drive (e.g. COM1)  
STP 1 Stop bits  
DAT 8 Data bits  
PTY NON Parity 
BAUD 9600 Baud rate (Bits per second)  
SIZE EXPAND-X Important as the point of origin is set at Lower Right  
Parameters TOOL CUTTER  
SPEED 15 will be overwritten by the software  
FONT OUTL  
P-CH IGNORED  

 
13. Allthough the “Read Back“ button is activated in CoCut Professional, this 

command always shows a zero value. How can I set up my Mimaki plotter 
so that the correct vinyl width is read in?  

 
The plotters of the Mimaki CG series will not react to the Read Back command unless 
they are operated in the host mode. 
For this proceed as follows: Switch on the plotter, press the <- key and once the plotter 
has measured the roll, press the function button until Priority appears in the display. 
Then press ENTER and after that the ^ key. The word “Host“ will now appear in the 
display. Confirm your selection by pressing ENTER. 
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14. After I have installed CoCut Professional for CorelDRAW 7 Ich can’t 
enlarge the Windows NT 4 toolbar. 

 
This problem only occurs with CorelDRAW 7 and Windows NT 4 and has apparently 
been eliminated in the latest version. 
 
However, there are two ways to avoid this problem:  
If you have another Windows 98 installation on your computer besides Windows NT 4, 
you should reinstall CorelDRAW 7 with Windows 98 and make sure that the installation 
is carried out into the same directory in which you have already installed CorelDRAW 7 
with Windows NT 4. After this, start CorelDRAW 7 with Windows 98 and adjust the 
toolbar, close CorelDRAW and restart your computer with Windows NT 4. 

 
If you have installed CorelDRAW 7 on another computer where Windows 98 is installed 
and have added the CoRun icon to the toolbar, you can copy the CDRBARS.CFG, 
CDRMENU.CFG and CDRROLS.CFG files from the CorelDRAW 7 DRAW directory on 
to a diskette and then copy them from the diskette to the DRAW directory on your 
Windows NT 4 computer. 

 
15. When I try to cut a text from CorelDRAW 6 with CoCut Professional I get 

the mesage Too Many Nodes. 
 
CorelDRAW 6 is only able to create a limited number of nodes (approx 3000) when 
converting text to curves. The more serifs and thus nodes the lettering has, the fewer 
letters can be converted into curves. 
 
You can only avoid this problem by creating several small text blocks with only a few 
letters, since it is not the total number of letters created but an excessive number of letter 
within a single block of text that leads to this problem. 
 
16. Question: What is the easiest way to cut a bitmap from CorelDRAW 9 or 

10? 
 
You must first of all vectorize your bitmaps as only curves can be cut. 
If you have also installed the CorelTRACE program with CorelDRAW, you can click on 
your bitmap using CorelDRAW and the Vectorize Bitmaps command will appear in the 
toolbar (or in the menu under Bitmaps). If you execute this command, CorelTRACE 
opens and offers you several Vectorize modes.  
 
You should normally choose Vectorize/By Wireframe. When you close CorelTRACE, 
the bitmap will be overlaid with the vectorized image and you can now cut the bitmap 
with CoCut Professional.  
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5. Glossary 
Terms printed in italics refer to additional glossary entries. 
 
Application Tape Tape used to transfer cut and weeded vinyl graphics to a 

substrate.  
The tape’s adhesion must be sufficient to hold even the tiniest 
letters while releasing them easily upon application. 

 
Ascender The part of a lower-case letter (e.g. b) that extends above the 

main body of the letter.  
 
Baseline Imaginary line on which all characters are placed in a line of text 

regardless of point size (with the exception of descenders). 
 
Bit Depth Mathematically possible number of colors for a given number of 

bits, e.g.: 1-bit color depth = 21 = 2 possible colors (black/white) 
8-bit color depth = 28 = 256 possible colors/graytones 24-bit 
color depth = 224 = 16.8 m possible colors 

 
Block CoCut Professional command for justifying text by which each 

line of text, excluding the last line, is extended to be flush with 
both the left and right margins.  

 
Bold Font which is somewhat thicker than the standard typeface. 
 
Byte Smallest addressable unit in the computer memory, consisting 

of 8 bits. 
 
Cap Height The height of a capital letter from the top of the letter to the 

baseline. Generally, the letter "H" is used for measuring. 
 
Clipboard An area in your computer’s memory used for temporary storage 

of data that was cut or copied. This data can be pasted from the 
clipboard into any file. 
This feature thus provides an easy way to transfer data from one 
program to another. 

 
CMYC Cyan, magenta, yellow, contrast (black). Standard colors for 

four-color printing. 
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CMYC Color Area Total amount of all colors represented by the CMYC colors 
used for printing. 

 
Color Depth The number of possible color tones that can be recognized by a 

scanner or reproduced on a color monitor. 
 
Contrast Difference between light and dark parts of an image. 
 
Descender The part of a lower-case letter (e.g. g) that extends below the 

main body of the letter. 
 
Desktop Space surrounding the working area on the computer screen, 

containing a variety of tools. 
 
Digitize To put an original image into digital form, either by entering 

points or lines through a digitizing table, or by using a scanner. 
 
Dongle Protective device included with CoCut Professional that must 

be plugged into the parallel port (LPT1, printer port) in order to 
run the software. Also called copy protection key, security lock, 
or hard lock. 

 
Download To retrieve programs or data via modem from an electronic 

mailbox and load them into your computer. 
 
EPS, EPSF Acronym for Encapsulated Postscript Format. File format in 

which text and image data are stored in postscript format. This 
format includes text and raster data as well as bitmaps for 
displaying it on screen. 

 
Font Designates a specific size and style of a particular typeface, e.g. 

12-point Helvetica, bold. Most typefaces include plain, bold, 
italic, and bold-italic fonts. The terms typeface and font are 
commonly (yet incorrectly) used interchangeably. 

 
Font Style Visual emphasis given to parts of a text string by adding text 

attributes such as bold, italic . 
 
Group Combining a number of objects in a group. Once objects are 

grouped, the positions of the objects relative to each other 
remain unchanged. 
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Halftone Image Designates an image that contains various shades of gray or of 
color. The shades between pure white and pure black are 
called halftones. 

 
Insertion Point Designates the blinking vertical line in a text box that can be 

edited. 
 
Justification The alignment of a text block in the working area, either along 

the left margin, right margin, or centered between the margins. 
In addition, CoCut Professional offers the following options: 
block or forced block and adjustment of cap height. 

 
Kerning The adjustment of spacing between characters to achieve type 

that is visually consistent and balanced. Characters may be 
extended (with kerning values above 100%) or condensed (with 
kerning values below 100%). 

 
Overfill A narrow overlapping area at the edges of areas of color which 

are positioned over each other. 
 This ensures that there are no streaks at the boundaries. The 

overlap can be created by using an overfill or an underfill. 
 
Point Unit of measure equal to approximately 1/72 of an inch used to 

measure printing type. Included in the measurement are 
ascenders and descenders as well as a certain space above 
and below the character. 

 
Process Colors Scale of colors for four-color printing with cyan, yellow, 

magenta and black (key); it is possible to print any color by 
mixing these colors. 

 
Resolution The amount of detail in an image as measured in dots or pixels 

per unit (e.g. dots per inch or dpi). Laser printers generally have 
a resolution of 300 to 600 dpi. 

 
Scanning Resolution Resolution for scanning analog images.  
 Formula: Resolution (in dpi) = printing length (L/cm) x 2 (quality 

factor) x enlargement factor x 2.54 (for converting mm to in). 
 
Streaks Cracks at the boundaries of overlapping or adjoining areas of 

color or vinyl. They are especially detrimental in screen-printing 
or printing. 
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Subscript Letters or characters placed below the baseline of normal text. 
Generally, such letters or characters are somewhat reduced in 
size. 

 
Superscript Letters or characters placed above the baseline of normal text. 

Generally, such letters or characters are somewhat reduced in 
size. 

 
Upload To send files and programs via a modem from your computer 

into an electronic mailbox system. 
 
Vinyl Generally, two types of vinyl are available, calendared and 

cast. Cast vinyl is not stretched during the production process 
and is therefore less prone to shrinkage. Cast vinyl is generally 
more costly than calendared vinyl which tends to have less 
durability and a greater tendency to shrink. Vinyl materials used 
for cutting generally consist of three layers: 

 
 1. Liner (the bottom layer) 
 2. Adhesive layer in between the liner and the vinyl 
 3. Vinyl material 
  
Weeding The act of removing excess vinyl around cut graphics. 
 
Working Area The area on your screen used for designing and editing. 
 
X Height The height (measured from the baseline) of a lower-case “x”, i.e. 

any lower-case letter without ascender, in a particular font. 
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Cable Configuration and Baud Rate 
Unfortunately a lot of plotters require a non-standard cable. For this reason we have 
decided to list the cable wirings necessary for the most important plotters below. We 
must, however, point out that we do not assume any responsibility for the correctness of 
this information. In addition, you should exercise great care in soldering your cable, as an 
improper connection can damage both your plotter and your computer.  
 
Such damage is not covered by any guarantee. 

Aristo 

 

Grapfityp 
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Houston 

EDMP series (old) 
 

 

Mimaki 
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Mutoh 

 

Perigraf 
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Roland 

 

Summagraphics D and T series 
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Zünd 
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Index 

A 

Accuracy  54 
Activated tile  45 
Adapt  35 
Adjust Curves  112 
Always in Front  79 
Arow tool  17 

B 

Back One  108 
Bitmap  118 
By Date  81 

C 

Centronics port  48 
Clockwise Rotation  106 
Close Contour  106 
CMX-Import  74 
CoCutSkin  9 
Color Separation in Cutting  54 
Context menu  80 
Contour Line  109 
Contrast  115 
Copy  102 
Counter-Clockwise Rotation  106 
Cursor shape  16 
Cursorform  16 
Cutting Preview  57 

D 

Deactivated tile  45 
Default Toolbar  17 
Delete  104 
Directory Groups  78 
Drill Holes  20 
Duplicate  104 
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E 

EuroFotoCUT  113 
Export  101 

F 

File Formats  85 
Filter Contours  112 
Forward One  108 
Full Page  107 
Full Surface  128 
Full-screen  79 

G 

Grayscale  116 
Group  105 

H 

Horizontal or Vertical  118 
Horizontal Weeding Lines  62 

I 

Insert  103 
Interior Parts  111 

J 

Job Manager  76 
Job Manager its desktop  77 
Job Manager Toolbar  78 

L 

Layer Settings  31 
Layerbox  29 

M 

Magnifying glass  107 
Material  51 
Material Data  51 
Material Default  51 



 
 
 

 

INDEX 

157

Maximal Optimization  60 
Measure  22, 125 
Mirrors  104 
Mouse  130 
Multi-Copy  27 

N 

Negative  116 
New Origin  54 
Number of Copies  38, 51 

O 

Online Support  136 
Online-Service  101 
Open  84, 100 
Optimize Output  60, 64 
Origin  54 
Output  50 
Overlap  43 

P 

Part-screen  79 
Passive Jobs  69 
Paste Contents  103 
Path Selection  79 
Perforation Mark/Drill Hole  106 
Plotter  130 
Preview Window  78 
Print  101 
Print Guidelines  38 
Printing area  35 

R 

RCS-ONLINE  75 
Read Back  51 
Ready to Cut  103 
Redo  102 
Reduce Tangential Points  112 
Refresh Screen  109 
Register (crop) marks  18 
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Register Marks  106 
Relative Position  24 
Rest Width  115 
Reveal Hidden Files  82 
Reverse Direction  117 
Rotate Axis  58 
Round Corners  107 

S 

Save  100 
Save As  101 
Screenprint  128 
Search Hard Disks  85 
Search In  86 
Search Mask  78 
Search Paths  78 
Sectioning  64 
Segment Offset  52 
Select All  82, 103 
Sheet Origin  53 
Show All  108 
Skew/Rotate  25 
Smooth Curves  112 
Snap to Edge  35 
Sort  52, 81 
Stack Offset  52 
Stack Preview  52 

T 

Tile  34, 40 
Tile Mode  41 
To Front  108 
Toolbor  17 

U 

Undo  102 
Ungroup  105 
Unselect  82 
Unselect All  82 
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V 

Vertical Weeding Lines  62 

W 

Wait after Segment  53, 131 
Weed Aid  120 
Weeding Border  52 

X 

X Mirror  59 

Y 

Y Mirror  59 

Z 

Zoom In  107 
Zoom Out  107 
Zoom Tool  21 

 
 
 



 

 

IMPRINT 

160

Imprint 
 
Production information: 
 
This manual was produced with Winword 2000 on a Pentium II 700 MHz. 
 
Fonts used: 
 
AcciusT 
 
German version: 
Georg Wagner, Peter Bettendorf,  
RCS Systemsteuerungen GmbH 
 
English translation: Hilary Teske 
 
 
 
May 2003 
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